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1 Getting Started

1.1 MapPro Overview

MapPro is a comprehensive desktop mapping application that has been developed to run with MapInfo
Corporation's MapInfo Professional.  MapPro is distributed on a CD that contains all the software plus
all the map data for up to one entire state.  The latest MapPro software and maps may also be
downloaded from MapPro's Support web site at www.mappro.net. MapPro enables users to
generate high quality color or black and white Location Maps, Flood Maps, Hazard Maps and Aerial
Maps that are needed for their normal business activities.

MapPro has a easy to use interface that allows inexperienced users the ability to create maps with just
a few clicks of the mouse and has powerful features to meet the mapping needs of more experienced
users.
* Unlimited number of property locations and arrows can be put a map.
* Add property locations from your own private database.
* Seamless maps across county boundaries.
* Map scale limits removed. Maps can show an entire State if desired.
* Create your own private map layers with the Database Utility.
* Select from 2 different sizes of property arrows and create any number of additional arrow types
with the Arrow Maker Utility.
* Automatic or Manual Map Data File naming.
* Automatic Map Labeling as you pan across the map.
* Text, lines, polygons, or symbols may be added to the map, are automatically saved with the Map
Data File and then automatically redisplayed when the file is opened again.
* Copy the MapPro Map Window into other Windows Applications such as Word, Excel, or Word
Perfect.
* Maps can be printed on letter, legal, or ledger size paper or printed to an Adobe Acrobat file for
sending them via email.

With MapPro maps can be created two different ways:

1. Map Maker is used to create maps when the user has one or specific addresses to be located on
the map.  Map Maker is initiated by creating a new map data file where all the address information is
saved.  One or more addresses are entered through a interactive dialog. The address, street name,
zip, grid, and city are verified and corrections can be made as needed.  The Location or Flood Map or
Hazard Map can then be displayed.

2. Map Viewer is used to create maps when the user does not have a specific address or just wants
to view the maps in an area.  After initiating Map Viewer, the map for entire Licensed area is
displayed. The user then selects the county and a grid area in the county to zero in on the area that is
desired.  A map frame is then positioned to exact area desired and the map is displayed.  Annotated
arrows may then be added to the map at any location desired or the drawing tools may be used to
add text, symbols, lines, or polygons to the map.  The Flood Map may also be displayed for the area
with a click of a button.

The Arrow Maker Utility is a feature that allows the user to create and define any number of
different Map Arrows that can be used on Map Maker Maps. With Arrow Maker you can set all the
attributes of an arrow - text, text font, text style and color, arrow color, fill, and border. Arrows can
also be designed to be automatically numbered when multiple arrows of the same type are used on a
map.

http://www.mappro.net
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The Database Utility is a powerful feature of MapPro.  Users can either create a new database or
import an existing database in dBase DBF or Microsoft Access formats to MapPro.  Users can also
import Microsoft Excel spreadsheets.  The database can then be geocoded with a comprehensive
geocoder to create a map layer to be used with MapPro.  Since the database remains in its original
format, the latitude, longitude, and updated address information may extracted and used to update
the original database.  Any number of database map layers may be created and preferences may be
set to always insert specific database map layers when displaying a map.

1.2 Supported Operating Systems

MapPro will run on Windows XP and new operating systems, including Windows Server editions.
MapPro is not compatible on Mac OS, however, many customers will be able to run MapPro in a
Parallels environment.  MapPro cannot provide technical support on configuring this setup.

1.3 Installation Guide

This is a guide to help get MapPro installed on your PC. This installation guide applies to either single
user MapPro License or a Demo License.  If you are installing MapPro with a Network License see the
Network Installation Guide.

1.  The MapPro Software may be either downloaded from MapPro's Support Web Site at
www.mappro.net or installed from a CD. If you are installing MapPro from the web site follow the
instructions on the web page. If you are installing MapPro from a CD insert your MapPro CD in your
CD Drive. Then click "Start", then "Run".  Click the "Browse" button.  Double-click on "My Computer"
and find your CD Drive where MapPro CD resides (you should see "MapPro80" label next the CD drive
letter.  Double-click on CD drive letter then double-click on "Setup.exe".  Click OK.  The dialog
"Welcome to the MapPro 9.0 Installation Wizard" should be displayed.

2.  Click "Next", rear the MapPro License Agreement and agree to the terms and click "Next" again.
The following dialog will be displayed.

http://www.mappro.net
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Enter your name, company name, and Serial Number. This Serial Number is case sensitive so enter it
exactly as shown. Then click "Next".

3.  A dialog is then displayed showing the installation location for MapPro. The default location is
"C:\MapPro".  The drive where MapPro is installed can be changed if your C Drive is full but it is not
recommended that you install it on a network drive or change the installation directory name.

4.  Click "Next". Another dialog is displayed saying "Ready to Install Application", click "Next" again.
MapPro will then be installed and a dialog will be displayed, "MapPro 9.0 has been successfully
installed" when the software installation is complete.

5.  The MapPro software installation is now complete. If you downloaded the MapPro software
installation from the web site MapPro will automatically download the licensed maps from the web site
after MapPro has been registered. If you installed MapPro from a CD leave the CD in the CD Drive for
now since the Maps will not be loaded until after you register MapPro.

Click "Finish"

1.4 Network Installation Guide

What is a MapPro Network License?
A MapPro Network License allows all workstations on a single Local Area Network to share one or
more MapPro Licenses. The network may be either a peer to peer network or a client-server network.
One workstation on the network is designated to be the "MapPro Network Host".  A program called
"MapPro Network Host" is installed on this workstation only. The MapPro Network Host program is
used to setup the network license initially and is used to reinitialize and/or update the network license.
The Host MUST have access to the internet. The only absolute requirement for a MapPro Network
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License is a shared hard drive somewhere on the network that is accessible by all computers on the
network. This is the location that contains the network license information. The disk space
requirement on this hard drive is minimal (less than 50k).

Advantages to a MapPro Network License
1.  Reduced Cost. By sharing a MapPro License on a network all workstations connected to the
network have access to MapPro with only a 25% additional charge for a one user network license.
Depending upon the number of users on the network, MapPro may be configured for up to 99 network
licenses.

2.  Ability to share maps with other users on the network. By specifying a network location where map
files are stored, maps may be created on one workstation but then opened by any other user on the
network.

Prerequisites
If you are installing MapPro on a network you should be familiar with your network and
have the knowledge necessary to share disk resources and map network drives.  MapPro
requires a shared directory on the network with full access rights enabled for all
computers that will be running MapPro on the network.  This is the key to the entire
MapPro network installation. MapPro Technical Support can provide you only limited help
in this area and is outside the scope of the actual MapPro Software.

Setting up MapPro on the Network - MapPro Network Host
1.  The workstation you select to be MapPro Network Host must be setup first. Install MapPro on this
workstation. At the beginning of the software installation process you will be prompted for a Serial
Number. All MapPro Network License Serial Numbers start with "ZN" and are 10 alpha-numeric
characters in length and are case sensitive. When this serial number is entered a checkbox
appears (This computer is Network Host). Check this checkbox.
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This forces the MapPro Network Host program to be installed. See the Installation Guide if you
need more help getting the MapPro software installed.

2.  After MapPro is installed,  run MapPro Network Host program by double-clicking the icon on the
desktop.

3.  Enter the Network License Path where the MapPro network license will reside. This directory can
not be located in the same directory that MapPro is installed. If network is a peer-to-peer
network a sub-folder under MapPro called "License" is recommended (ie. enter C:\MapPro\License\). If
this directory will reside on a server the choice of location and directory name is yours to make. If the
directory does not exist MapPro Network Host will create it. Make sure that this Network License Path
is accessible to all computers on the network that will be running MapPro and that full access rights
are enabled to this directory and that each computer on the network that will run MapPro has this
shared resource mapped to a drive letter.

4.  The Serial Number entered at the time of the installation is then displayed. Verify it is correct.

5.  Enter your Company information.

6.  After all the above information has been entered, verify you are connected to the internet if you
have a dialup connection and click the OK button. The MapPro Network Host program will exit and
automatically restart after registration is complete and will display the message: "MapPro License
Updated Successfully".

7.  Now you are ready to start MapPro on the Network Host Computer. MapPro on the Network Host
works just as it does on any other computer on the network in that it shares the MapPro license with
all other computers. After starting MapPro enter the "ZNxxxxxxxx" serial number.  The Directory
Preferences will then be displayed.

8.  The Network License Path is the key here. Set the Network License Path to point to the same path
as you did for the Network Host in step 3 above.

9.  The Data Directory Path could be set to point to a place on the network that allows all of these files
to be saved in a shared location.  The advantage to this is that maps can be created on one computer
on the network and then the same opened by other computers on the network.

10.  It is NOT recommended that the Map Directory Path reside on the network. This will adversely
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affect the performance of MapPro and put a heavy load on the network when MapPro is used.

11.  After MapPro sees a valid Network License Path it will determine what maps are licensed and
proceed to load the licensed map files from one or more CDs or from a downloaded zip file.

Setting up MapPro on the Network - Other Network Workstations

1.  With a network license, MapPro may be installed on any computer on the network.
2.  After MapPro is installed on a workstation, follow steps 7 thru 11 above. Make sure that you have
the folder to the Network License Path on the MapPro Network Host computer shared with full access
rights and have Mapped this shared resource to a drive letter on each workstation that MapPro is
installed.

1.5 Registering MapPro

1.  The MapPro Software places a MapPro icon on your Windows Desktop. Double-click on the MapPro
icon to start and register MapPro.  MapPro will start and the following dialog will be displayed.

The Serial Number that you entered during the software installation should be displayed. Verify that it
is correct. if it is not correct change it now. Then click Ok.

2.  The following dialog will be displayed to obtain your company information.
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Enter all the requested information, then click Ok.

3.  MapPro must connect to the MapPro Server via the Internet to register your copy of MapPro and
obtain the Map License information.  If you have a firewall installed on your computer it may be
necessary to temporarily disable it to allow the MapPro communications software to connect to the
MapPro Server.

4.  If you receive a "Copyright Violation" message, re-verify the Serial Number you entered (serial
number is case sensitive) and try again.  If you receive any other error message contact MapPro
Technical Support.  After MapPro has registered the following dialog will be displayed.

5.  MapPro must now load the maps required for your installation of MapPro. Maps may be loaded
from an installation CD or from a zip file downloaded from the web site.

Select the Map source. If you selected Web proceed to Step 8 otherwise go to Step 6.

6.  The following dialog is displayed to obtain your CD drive letter and the destination path where the
maps will be saved.  This information should all be correct.  The CD Drive path should point to drive
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that contains the MapPro Installation CD. Click Ok.

7.  If you see a dialog similar to the following, you may have removed the CD from the drive or you
have it inserted it into a second CD drive on your system.  If this occurs insert MapPro CD or select
"Change" and change the CD Drive Path to point to the correct location.

Go to Step 9.

8.  If you selected "Web" in Step 5, MapPro will automatically download a zip file containing the
licensed maps from MapPro's web site and save the file.  The file is saved in a directory called
"Download" under the MapPro directory if you have a Single User License or a Demo License or in the
Network License Path if you have a Network License. An estimated download time for several different
types of internet connections is displayed in a message window. After the download is complete or if
the file has been previously downloaded the licensed maps are unzipped automatically into the
appropriate state directories and all the required map layers are then created.

9.   After all the maps have been loaded and map layers have been created the following dialog is
displayed.

1.6 User Preferences

Selecting User Preferences from the File Menu displays the following dialog:
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User Type
MapPro is currently designed to support three different types of users- Real Estate Appraiser, Real
Estate Broker, and Other. The only difference in these three user types is the way the fields in the
header of the printed maps are defined.

The Real Estate Appraiser User Type header contains fields for File No., Borrower or Owner, and
Lender or Client.
The Real Estate Broker User Type header contains fields for Client, Agent, Agent's Office Ph., and
Agent's Home Ph.
The Other User Type header is a free form header containing a Description field.

Map Font
Map Font allows the default map font to be changed.  Font sets the font type for all labels on the map.
The size sets the font size for street and water labels - 6 is the default. Note that a font size less than
8 must be manually entered.  The larger font sizes result in fewer streets being labeled since the
automatic labeling does not allow labels to overlap each other. The color, background, and effects of
the font is controlled internally by the software and therefore have no effect.  Arial font is the default.
This is a standard Windows font and works very well on the maps where text is printed at virtually
every angle. True Type fonts generally print better at smaller font sizes.

Map Layer Options
The following Map Layer Option set the default settings for certain map layers.  All of these settings
may also be controlled through selections on the Options Menu after a map is displayed.

Display Pnts of Interest  Check this box to display the points of interest layer on the map. The
points of interest layer contains schools, parks, golf courses, cemeteries, churches, shopping centers,
etc. and some users may not want this layer displayed since it adds numerous maps points that may
not be needed for their particular application.  This layer may also be temporarily turned on or off by
selecting the Display Points of Interest selection on the Options Menu.
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Display Strts on Aerial  This check box will only be enabled if the optional Infrared Aerials, available
for some areas, have been purchased.  Checking this box causes the street maps to be overlayed on
top of the aerial images.

Display Parcel Maps   This check box will only be enabled if the you have subscribed to the optional
Parcel Maps. (Currently only available for portions of the Houston area)  Checking  this box causes the
parcel maps to be automatically displayed when the map scale is 2 miles or less.

Display Topo Maps   This check box will only be enabled if the you have subscribed to the optional
Topo Maps. (Currently only available for the Houston area)  Checking  this box causes the topo maps
to be automatically displayed when the map scale is 2 miles or less.

Display One Way Strts  Check this box to display the one way streets layer on the map. The one
way streets layer layer contains arrows indicating the direction of one way streets. These directional
indicators are displayed when the map scale is 2.5 miles or less.  Some users may not want this layer
displayed since it can add numerous arrows to the map that may not be needed for their particular
application.  This layer may also be temporarily turned on or off by selecting the Display One Way
Streets selection on the Options Menu.

State/County Defaults
The State / County Defaults specifies the default State and County for the Map Point Data dialogs.
Selecting "(All Counties)" for the County default causes MapPro to use the Zip Code of the property
address to find its location. Selecting a specific county causes MapPro to search only that county.

Map Scale Default
Min. Map Scale: Sets the minimum desired size of a map created using Map Maker. This distance is
the horizontal or East/West distance across the map.  The default value is 3 miles. There are no
restrictions on what this value can be. It can be as little as .01 miles or as large as 100 miles.  You
may want to experiment with this setting to find a value that suits your needs. This setting only
controls the minimum map scale, it does not control the maximum map scale. When more Map Point
location is entered, MapPro dynamically scales the map so that all of the entered Map Point locations
are shown. This could result in a map being displayed that is 30 miles or more across.
This also sets the initial size of the map frame displayed in Map Viewer.  This is the horizontal or
East/West distance across the map frame. The North/South distance is determined by this value along
with the paper size.

Default Property Symbol
The Default Property Symbol preference sets the default property symbol style to be used on all Map
Points.  There three possible selections: Small Arrow, Large Arrow or Icon.  Select the radio button
next to the desired selection.  If Icon is selected, the default symbol style for the icon may be selected
by clicking on the Icon Button.  All font names beginning with "MapInfo" contain symbols provided by
MapPro although any font in the list may be selected.  Browse through the various fonts to find a
symbol that fits your needs.

Printer / Paper Size Preference
Printer / Paper Size Preference is used to specify which printer and paper size will be used for MapPro
maps. Initially this is set to the Windows default printer. This setting is saved with each file so if you
set a certain map file to print on a specific printer this setting will be restored when the same map file
is opened again. MapPro installs a PDF Printer that may be used to generate Adobe PDF output. The
name of this printer is "MapPro PDF Printer". PDF output may be sent to any specified directory. A
default directory "PDFOut" is created under the MapPro directory that may be used for this output.



MapPro Help14

Copyright © 1994-2020 MapPro, Inc.

Resolution - Visible only if "MapPro PDF Printer" is the selected printer. Use to set the PDF file output
resolution. Available settings are 300, 600, and 1200 DPI.

PDF Output Directory -  Visable only if "MapPro PDF Printer" is the selected printer. Directory where
PDF output will be sent. Default is "C:\MapPro\PDFOut\".

Selecting the Print Setup button allows the paper size and/or the default MapPro printer to be
changed.

Selected Output Destination
Selected Output Destination determines whether Maps will be printed to the selected Printer or Maps
will be sent to the specified Image Directory when the Print Map button is pressed or Print is
selected from the File Menu.

Image Output Preferences
MapPro has a feature that allows Maps to be printed to image files. These files will be saved in the
specified Image Directory with the Image Type, Size and Resolution specified.  This is very useful if
you have a need to import MapPro's maps into other applications.  The naming convention for these
files is as follows; If for example the MapPro Map Data file name is "123456" and the specified file
type is "WMF", then the file name for the Location Map would be "123456_Location_Map.wmf" and
the Flood Map would be "123456_Flood_Map.wmf".  When images are created the normal header
which appears on the printed maps is removed since this header is provided by most applications to
which these maps will be imported. Selecting the Settings button allows the Image Output
Preferences to be changed.  If you are integrating MapPro with a residential appraisal software, you
should set the image output type to PNG.

1.6.1 Print Setup

Print Setup displays the following Page Setup dialog.  Make sure the paper size is set correctly. Page
margins are controlled internally in the MapPro software so leave these settings at their default values.
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Select a different printer by clicking on the "Printer..." button. Click down arrow next to Printer Name
to select a different printer.
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1.6.2 Image Ouput Preferences

Selecting the Settings button for Image Output Preferences displays the following dialog:

Image Width - Set Image Width to match custom paper size width.
Image Height - Set Image Height to match custom paper size height.
Image Type - Select the Image Type for saved images. The following image types are available:

"BMP" specifies Bitmap format
"WMF" specifies Windows Metafile format
"JPEG" specifies JPEG format
"PNG" specifies Portable Network Graphics format
"TIFF" specifies TIFF format
"PSD" specifies Photoshop 3.0 format
"TIFFCMYK" specifies TIFF CMYK format
"EMF" specifies Windows Enhanced Metafile format.

Resolution - Image output resolution in DPI. Recommended values: 96, 100, 150, 200, 300, 600.
Increasing resolution can significantly increase file size. Doubling resolution will quadruple file size.
Image Directory - Enter the full path where images will be saved.
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1.7 Directory Preferences

Data Directory Path
Data Directory Path tells MapPro where the Map Data Files (.mpd) are located.  The default location of
this path is "C:\MapPro\Data\".  If the Map Data Files will be shared with other users on a network
drive, the path should be "N:\PATH\MapPro\Data\" where N is the mapped network drive letter and
\PATH is the path (if any) on the network drive.

Map Directory Path
Map Directory Path tells MapPro where the Map Files are located. The default location is
"C:\MapPro\Maps\".  The Map Directory Path is the largest portion of the disk space requirement for
MapPro.  If you do not have sufficient space on your "C:" drive you may enter an alternate drive.  It is
not recommended that you install the maps on a network drive since this will significantly slow down
the creation of maps in addition to putting a heavy load on your network.

Database Directory Path
Database Directory Path tells MapPro where the User Database Files are located.  The default location
is "C:\MapPro\Database\".  No databases are provided but databases may be created or imported with
the Database Utility creating your own private map layers.  If the Database Files will be shared with
other users on a network, the path should be "N:\PATH\MapPro\Database\" where N is the mapped
network drive letter and \PATH is the path (if any) on the network drive.

Default Database Layers
Default Database Layers is used to specify the default database layers that will be automatically added
to all Map Viewer and Map Maker maps.  This preference provides a very convenient way to map
database layers that you always use.  See User Database Layer for details.
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10m Aerial Image Path
If you have not purchased any aerial image data from MapPro this field will be disabled. 10m Aerial
Image Path tells MapPro where the optional 10 meter aerial image files are located.  The 10m Aerial
Images normally require in excess of 100MB of disk space.  If you have a sufficient amount of free
hard disk space and you plan to use the aerial images frequently, install the 10m Aerial Images on
your hard drive.  The default path is "C:\MapPro\Image\".   If you did not install the 10m Aerial
Images on the hard disk, this path should be "X:\" where X is your CD-ROM drive letter. The CD-ROM
Drive check box must also be checked.  You may install the 10m Aerial Images on a network drive the
path should be "N:\PATH\MapPro\Image\" where N is the mapped network drive letter and \PATH is
the path (if any) on the network drive.

Hi-Res Aerial Image Path
If you have not purchased any aerial image data from MapPro this field will be disabled.  Hi-Res Aerial
Image Path tells MapPro where the optional 2.5 meter or 1 meter Aerial Image Files are located.
The Hi-Res Aerial Images can require large amounts of disk space.   For operation with a CD-ROM
drive this path should be "X:\" where X is your CD-ROM drive letter. The CD-ROM Drive check box
must also be checked.  You may install the Hi-Res Aerial Images on a network drive the path should
be "N:\PATH\MapPro\Image\" where N is the mapped network drive letter and \PATH is the path (if
any) on the network drive.

Network License Path
Network License Path  Network License Path is only used when MapPro has been installed with a
network license.  It contains the path on the network where the network license files for the network
workstations are stored.  The MapPro Network Host computer is responsible for initializing these files
at the time of installation or when the network license is updated.  Each MapPro Network Workstation
must enter a path to the same location as specified on the MapPro Network Host.  Once a valid path
has been entered on the MapPro Network Workstation this field becomes disabled and can no longer
be changed.  When a peer to peer network is used, the Network License Path must NOT be set to the
installation directory for MapPro on the Network Host (normally C:\MapPro\). In this case set the
Network License Path to "C:\MapPro\License\".

1.8 Startup Button Bar

New Map Data File
Selecting the New Map File button on the Startup or Map Functions Button Bars or selecting New
Map Data File from the File Menu causes a new Map Maker data file to be created.  A date coded
file name, using year, month, day and a sequential number starting at 01 thru 99, is displayed as the
default file name in the New Map Data File dialog.  You may either use this name or enter your own
file name.  The default File Type for Map Data Files is "mpd" (MapPro Data).  These files are save in
the Data Directory Path which is normally "C:\MapPro\Data".  DO NOT change this path here. Select
Directory Preferences if you would like these files saved in a different location. After the Map Data
File has been created the Map Point Data dialog is displayed where Map Points for the Map Maker
Map can be entered.  Once the file has been created, Open Map Data File may be selected to reload
all saved information relevant to a map.



Getting Started 19

Copyright © 1994-2020 MapPro, Inc.

Open Map Data File
Selecting the Open Map File button on the Startup or Map Functions Button Bars or selecting Open
Map Data File from the File Menu displays a dialog where a previously created Map Data File may
again be opened.  Select the desired Map Data File and select Open or double-click on the file name.
When the file is opened, the Map Point Data dialog is automatically displayed so that the Map Points
may be reviewed prior to displaying a map.

Map Viewer
Map Viewer is a feature of MapPro that allows an area within a licensed counties to quickly be
displayed without having to enter an actual street address.  This can be very useful if you are dealing
with a tract of land which has no actual address or in rural areas where rural route addressing is used.
With Map Viewer, these maps can be quickly be displayed with just a few clicks of the mouse. Click
here for more information on the use of Map Viewer

Database Utility
The Database Utility is a MapPro feature that provides users the capability to create databases or
import existing Microsoft Access or dBase databases.  These databases may then be geocoded (the
process of assigning X and Y coordinates to the database records so they can be displayed as objects
on a map) and then added as layers to the map.   Click here for more information on the use of
Database Utility

Arrow Maker
The Arrow Maker is a utility that allows users to create or modify arrows that are used on the maps in
MapPro.  Click here for more information on the use of Arrow Maker

Exit MapPro
Exit MapPro terminates execution of MapPro.

Help
Displays MapPro Help

1.9 Updating MapPro License

MapPro is a software as a service application.  An internet connection is required to obtain this
information from the MapPro Server.  Each licensed computer has a unique Serial Number that is used
to initially register the company information and obtain the authorization for the licensed map and
data options.  Once registered, only the specific computer that initially registered a particular Serial
Number may obtain license updates for that licensed Serial Number.  Any attempt to register a
MapPro Serial Number previously registered on another computer will result in a Copyright
Violation.  If you would like to move the licensed serial number to another computer or if your
original computer has had problems and the software was reloaded contact MapPro at 713-789-1406
for assistance.

When MapPro is started and 10 or fewer days remain until the expiration of the License a message
similar to the one below will be displayed.
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The About MapPro... selection on the Help Menu will also tell you the number of days that remain on
the license at any time.

When the license expires, the following message will be displayed:

With a MapPro Network License one workstation on the network is designated the MapPro Network
Host for the network.  This computer is responsible for administrating MapPro on the network with the
use of a separate program called "MapPro Network Host".  The last two digits of the serial number
determines how many licenses may be active on the network at any one time.  All licenses float on the
network and are available to any computer on the network that has MapPro installed. With a Network
License, when MapPro is started on any workstation and 10 or fewer days remain until the expiration
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of the License a message similar to the one below will be displayed.

When the license expires, the following message will be displayed. MapPro will automatically exit and
can no longer be used

1.10 Technical Support

The latest MapPro software, software updates, map updates and other information is available on
MapPro's Support web site at www.mappro.net

If you encounter problems working with the MapPro Software or have difficultly accessing the MapPro
Server, our technical support specialists can help.

Please have your MapPro Serial Number ready before you call Technical Support.

Technical Support Phone: (713) 789-1406
Technical Support Email: support@mappro.com

http://www.mappro.net
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2 Reference Documents

2.1 Flood Zone Definitions

The following are the flood zone definitions as stated on the FEMA Flood Insurance Rate Maps:

Special Flood Hazard Areas Inundated by 100-Year Flood (Shaded cyan, blue, green, &
violet on Flood Map)

Zone A:  Areas of 100-year flood; No base flood elevations determined.
Zone AE: Areas of 100-year flood; Base flood elevations determined.
Zone AH: Areas of 100-year flood; Flood depths of 1 to 3 feet (usually areas of ponding); Base flood
elevations determined.
Zone AO:  Areas of 100-year flood; Flood depths of 1 to 3 feet (usually sheet flow on sloping terrain);
Average depths determined.  For areas of alluvial fan flooding velocities also determined.
Zone A99:  Areas of 100-year flood; To be protected from 100-year flood by Federal flood protection
system under construction; No base elevations determined.
Zone V:  Areas of 100-year flood; Coastal flood with velocity hazard (wave action); No base flood
elevations determined.
Zone VE:  Areas of 100-year flood; Coastal flood with velocity hazard (wave action); Base flood
elevations determined.
Zone A1-A30:  Areas of 100-year flood; Base flood elevations and flood hazard factors determined.

Other Flood Areas (Shaded yellow on Flood Map)

Zone X:  Areas of 500-year flood; Areas of 100-year flood with average depths of less than one foot
or drainage areas less than one square mile;  and areas protected by levees from 100-year flood.
Zone B:  Areas of 500-year flood; Areas of 100-year flood with average depths of less than one foot
or drainage areas less than one square mile;  and areas protected by levees from 100-year flood.
Zone X500L: Areas where the 500-year flood zone (area with 0.2% annual chance of flooding) is an

area protected by a levee (may be provisionally accredited).
Zone OW: (Shaded blue on Flood Map) Areas designated as open water areas. These are areas
within county or community administrative boundaries but not covered by FEMA flood zones. In the
past, we had either not captured such polygons or used a zone code of the closest properly coded
polygon (typically V or VE). Please note the OW zone shall not be considered a Special Flood Hazard
Area but it may be associated with a CBRA area. If any address point or street segment intersects with
this new zone code it should be manually reviewed.

Other Flood Areas (Not shaded on Flood Map)

Zone X:  Areas determined to be outside 500-year flood-plain; Areas of minimal flooding.
Zone C:  Areas determined to be outside 500-year flood-plain; Areas of minimal flooding.
Zone D:  Areas in which flood hazards are undetermined.

Areas shaded pink on Flood Map are areas that do not participate in FEMA's National Flood
Insurance Program.

2.2 FEMA Q3 Flood Data Use Policy

This section presents FEMA's use policy regarding the Q3 Flood Data.  It provides separate policy
statements for standards of care, Community Rating System, and flood determination uses and also
explains the "Good Faith Standard."  Complete "Q3 Flood Data Users Guide" may be obtained from
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FEMA's web site.

Standards of Care

For the development of applications using the Q3 Flood Data, the user has the following
responsibilities:

l to obtain and review the technical documentation of the Q3 Flood Data, with particular regard to
the limitation of this product;

l to establish minimum mapping and accuracy standards required for the proposed application;

l to obtain digital base maps and ancillary data of appropriate scale, resolution, and accuracy to
support the applications; and

l to determine whether Q3 Flood Data is based on the currently effective FIRM panel.

The quality, accuracy, and reasonableness of any applications developed using Q3 Flood Data are the
sole responsibility of the end-user.

The Q3 Flood Data product is not suitable for engineering applications such as detailed site design and
development plans, Letters of Map Change, or submittal of FIRM Map Revisions.

Community Rating System

For the purposes of the Community Rating System (CRS), Q3 Flood Data may be used in the following
ways:

l  for calculations of SFHA areas and similar applications that require geographic calculations and
measures;

l  for partial fulfillment of GIS provisions per the provisions of Section 440, "Flood Data
Maintenance," as described in the National Flood Insurance Program Community Rating System
Coordinator's Manual (Reference 5); and

l  for development of "notification" lists of potentially flood-prone properties, per the provisions of
Section 330; and

l  for partial fulfillment of credits for the performance of flood determinations, when performed in
conformance with guidelines for determination presented below.

Flood Determinations

The Q3 Flood Data can support flood determinations in a limited fashion, in conformance with the
"Good Faith" standard, if used within the following guidelines:

l  The end user has obtained a source of address or property location data and combined it  with
Q3 Flood Data in a manner that conforms to the Standards of Care outlined above.

l  The end user has made no determinations as to the flood prone status of a property that is
within 250 feet of an SFHA boundary.  This requirement is due to the accuracy, resolution, and
variations of the Q3 Flood Data relative to the source FIRMs.
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l  The end user has verified that the Q3 Flood Data FIRM panel and suffix conform to the panel
and suffix of the currently effective FIRM.

l  The end user has confirmed the availability of flood insurance in the community for which the
determination is to be offered.

l  The end user has confirmed the zone and BFE with the source FIRM or DFIRM for properties
located within 250 feet of the SFHA boundary or within the SFHA.

The "Good Faith Standard"

The mandatory flood insurance purchase requirements of the 1973 National Flood Insurance Act apply
only when a structure is located in an SFHA in a community that is participating in the NFIP.  Such a
structure must be insurable under the rules of the NFIP.  Even though a portion of the land parcel
upon which the structure is planned or built may be within an SFHA, the mandatory purchase
requirement is triggered only if the structure itself is within an SFHA.

The compliance of lenders with the mandatory flood insurance purchase requirements of the 1973 Act
is based on the "good faith standard."  Determining whether a structure is located in an area of
special flood hazard requires the examination of the location of the structure in relationship to the
areas of special flood hazard as shown on the applicable FIRM.  The good faith standard recognizes
that despite FEMA's best efforts to make the FIRMs as useful as possible, the descriptions of SFHA
areas, as depicted by some maps, may, in some instances, not be clear enough to permit lenders to
decide with certainty and precision whether or not property that is the security for a loan or that is the
subject of financial assistance is located in such an area.  It is for this reason that FEMA has
recommended a "good faith standard."

The good faith standard requires lenders to exercise "due diligence and good faith" in determining the
location of a property that is the subject of a loan relative to areas of special flood hazards as shown
on a FIRM.  This guidance is further explained, with additional information on the 1973 Act, in  the
publication Mandatory Purchase of Flood Insurance Guidelines (Reference 6).
When determinations are being made by lenders, or firms or individuals retained by lenders to assist
in these endeavors, collateral data in addition to the FIRM is frequently required.  FIRMs do not
include all roads within communities, nor do they depict address, property boundary, or structure
location information.  As a result, determinations frequently can be made only by using an ancillary
source of data, such as a land parcel map, to determine the location of a property on the FIRM.

Digital address range data, land parcel, and structure information is available for many communities
across the nation.  Using these digital data and GIS technology, it is possible to make determinations
relative to the 1973 Act and meet the good faith standard.  However, the lenders must assure that
due diligence and good faith are exercised in application of digital mapping systems to make
determinations.  Because of both the increased complexity and analytical capabilities of GIS, assuring
compliance with the good faith standard may require additional effort relative to use of paper maps.

A prime concern is to assure that the accuracy of the digital base map and structure location data are
appropriate for use with the chosen digital FIRM data set (DFIRM or Q3 Flood Data) to make
determinations relative to the 1973 Act.  The concern for accuracy of the ancillary data used with
DFIRMs should increase in direct proportion to the relative closeness of the property under analysis to
the SFHA boundary.  Thus, lenders might not find it prudent to use digital data at the 1:100,000 scale
as the primary source of information upon which to make a determination regarding a property
located within 250 feet of an SFHA.  Such caveats should be carefully considered when U.S. Bureau of
the Census TIGER data are used as the source from which property determinations will be made.
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In some instances, GIS technology will enable the use of large-scale land parcel, topographic,
structure, and other information, with  digital FIRM data to make determinations.  GIS technology
allows maps to be created at any user-specified scale.  Enlargement of scales does allow for precise
determinations to be made.  However, precise measurements are not inherently accurate.  Accuracy
can only be assessed from an appraisal of the quality of source data.

SFHA boundary information conveyed by Q3 Flood Data files was developed to overlay USGS 7.5-
minute topographic maps at a scale of 1:24,000.  Thus, Q3 Flood Data cannot be assumed to have an
accuracy of better than 40 feet.  Due to other limitations, FIA recommends that determinations using
GIS technology and Q3 Flood Data generally be made only when structures are located 250 or more
feet outside an SFHA boundary.  In cases where the structure is within 250 feet of the SFHA or inside
the SFHA, data such as the BFE determined from a FIS flood profile and the surveyed lowest adjacent
grade and/or lowest floor elevation should be used to make a determination.

Prudence may require that a more conservative margin than 250 feet be used to determine the need
for ancillary data to support a GIS determination.  Terrain variations, the nature of flood hazards in the
area, and the quality of all digital data being used to make the determination should be considered
when establishing the need for collecting survey and flood profile data.

2.3 Environmental Hazard Types

NPL (National Priorities List)
     List compiled by the EPA pursuant to CERCLA 42 USC Subsection 9605(a) (8) (B) of properties
with the highest priority for cleanup pursuant to EPA's hazard ranking system.  See 40 CFR Part 300.
Source:  United States Environmental Protection Agency

D-NPL (Delisted Sites from the National Priorities List)
     Sites that have been deleted from the National Priorities List.
Source:  United States Environmental Protection Agency

CERCLIS (Comprehensive Environmental Response, Compensation and Liability Information
System)
     The list of sites compiled by EPA and that EPA has investigated or is currently investigating for
potential hazardous substance contamination for possible inclusion on the National Priorities List.
Source:  United States Environmental Protection Agency

NFRAP (No Further Remedial Action Planned)
     The list of sites compiled by the EPA that to the best of the EPA's knowledge, Superfund has
completed its assessment of a site and has determined that no further steps will be taken to list that
site on the NPL.
Source:  United States Environmental Protection Agency

CORRACTS (RCRA Corrective Action Sites)
     List of hazardous waste treatment storage or disposal facilities and other RCRIS facilities (due to
past interim status or storage of hazardous waste beyond 90 days) who have been notified by the US
Environmental Protection Agency to undertake corrective action under RCRA.
Source:  United States Environmental Protection Agency

RCRA TSD (RCRA Treaters, Storers, or Disposers of Hazardous Waste)
     List maintained by the EPA of those facilities on which treatment, storage, and/or disposal of
hazardous wastes takes place, as defined and regulated by RCRA.
Source:  United States Environmental Protection Agency

RCRA GEN (RCRA Generators of Hazardous Waste)
     List maintained by EPA of those persons or entities that generate hazardous waste as defined and
regulated by RCRA, includes Small Quantity Generators (SQGs), Large Quantity Generators (LQGs)
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and Conditionally-Exempt Small Quantity Generators (CESQGs).
Source:  United States Environmental Protection Agency

ERNS (Emergency Response Notification System)
     EPA's Emergency Response Notification System list of reported CERCLA hazardous substance
releases or spills in quantities greater than the reportable quantity, as maintained at the National
Response Center.  Notification requirements for such releases or spills are codified in 40 CFR Parts
302 and 355.
Source:  National Response Center

FED-BROWNS (Federal Brownfields Sites)
     Brownfield sites receiving federal grants.
Source:  United States Environmental Protection Agency

DEA-LABS (US Drug Enforcement Administration (DEA) National Clandestine Laboratory
Register)
     The U.S. Department of Justice provides listing of addresses of some locations where law
enforcement agencies reported they found chemicals or other items that indicated the presence of
either clandestine drug laboratories or dumpsites. In most cases, the source of the entries is not the
Department, and the Department has not verified the entry and does not guarantee its accuracy.
Members of the public must verify the accuracy of all entries by, for example, contacting local law
enforcement and local health departments. Sites are mapped as State Supplemental database sites.
Source:  US Department of Justice, Drug Enforcment Agency

TRIBAL UST (Tribal Underground Storage Tanks)
     Sites compiled by the various EPA Regions with underground storage tanks on tribal lands.
Source: EPA Regional Offices

TRIBAL LPST (Tribal Leaking Underground Storage Tanks)
     Sites compiled by the various EPA Regions with leaking underground storage tanks on tribal lands.
Source: EPA Regional Offices

SPL (State Funded Superfund Sites)
     Sites included in this category are included in a state's database of superfund sites, but may or may
not be included in the US EPA CERCLA database.  Available information varies by state
Source:  State Government Agency

SCL (State CERCLIS Sites)
     Sites included in this category serve as a state equivalent to the US EPA CERCLA database.
Information available varies by state.
Source:  State Government Agency

SWLF (Solid Waste Landfills)
     Includes state landfill and/or solid waste disposal sites in a database maintained by state agencies.
Information available varies by state.
Source:  State Government Agency

CLI (Closed Landfill Inventory)
     Lists of landfills that may be closed or unpermitted.
Source:  State Government Agency

UNAUTH (Unauthorized Landfills)
     Includes state landfill and/or solid waste disposal sites that are either unpermitted or unauthorized.
Source:  State Government Agency

Brownfields (Brownfields Site Assessments)
     State maintained list of completed and ongoing Brownfield Site Assessments.  Available information
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varies by state.
Source:  State Government Agency

BROWARD-BF (Broward County Brownfields Redevelopment Sites)
     Broward County, Florida maintained list of completed and ongoing Brownfield Site Assessments.
Available information varies by state.
Source:  Broward County Pollution Prevention & Remediation Division

ICR (Institutional Controls Registry)
     This list contains sites listed in the state's or department's Institutional Controls Registry (ICR). The
information in the ICR summarizes certain data about properties where institutional and engineering
controls are used to control exposure.
Source:  State Government Agency

RRC-Browns (Railroad Commission Brownfields Site Assessments)
     State of Texas maintained list of completed and ongoing Brownfield Site Assessments.  Available
information varies by state.
Source:  State Government Agency

VCP (Voluntary Cleanup Program Sites)
     State maintained list of sites undergoing voluntary cleanup.  Institutional controls are included for
some sites.  Available information varies by state.
Source:  State Government Agency

RRC-VCP (Railroad Commission Voluntary Cleanup Program Sites)
     State of Texas maintained list of sites undergoing voluntary cleanup.  Available information varies
by state.
Source:  State Government Agency

LPST (Leaking Petroleum Storage Tanks)
     State lists of leaking aboveground and underground storage tank sites.  Section 9003(h) of Subtitle I
of RCRA gives EPA and states, under cooperative agreements with EPA, authority to clean up
releases from UST systems or require owners and operators to do so. Available information varies by
state.
Source:  State Government Agency

PST (Petroleum Storage Tanks)
     State lists of underground and/or aboveground storage tanks required to be registered under
Subtitle I, Section 9002 of RCRA.  Available information varies by state.
Source:  State Government Agency

UST (Underground Storage Tanks)
     State lists of underground storage tanks required to be registered under Subtitle I, Section 9002 of
RCRA.  Available information varies by state.
Source:  State Government Agency

St-Suppl (State Supplemental Database Sites)
    Sites mapped with this symbol may be from any of the databases below.

IOP (Innocent Owner-Operator Program)
     State maintained list of sites undergoing cleanup based on innocent owner/operator determination.
Available information varies by state.
Source:  State Government Agency

AST (Aboveground Storage Tanks)
     State maintained list of registered aboveground storage tanks.  Available information varies by
state.
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Source:  State Government Agency

DRYCLEANER (Registered Dry Cleaning Facilities)
     State maintained list of dry cleaning facilities and drop stations.  Available information varies by
state.
Source:  State Government Agency

IHW (Industrial Hazardous/Solid Waste Facilities)
     State maintained list of permitted hazardous and solid waste facilities.  Available information varies
by state.
Source:  State Government Agency

St-Spill (State Spill Registry)
     State maintained list of reported spills.  Data may be duplicated in National ERNS list.  Available
information varies by state.
Source:  State Government Agency

2.4 Census Tract Demographics

When a Location Map is displayed Census Tract Demographic information may be displayed with the
use of the Info Tool.  Below is a table containing the field names for the CT layer and a description
for each field.  Source of Data: US Census Bureau 2000 Census

CT Census Tract Number
FIPS Full Census Tract Number including State, County, and Census Tract

POP_2000 Total population
POP_WHITE White alone
POP_BLACK Black or African American alone
POP_AIAN American Indian and Alaska Native alone
POP_ASIAN Asian alone
POP_NHPI Native Hawaiian and Other Pacific Islander alone
POP_OTHER Some other race alone
POP_2RACE Two or more races
POP_HISPLAT People who are Hispanic or Latino

MED_AGE Median age Both sexes
MED_AGE_M Median age Male
MED_AGE_F Median age Female

HH_POP Total Population in households
HH_AVGSZ Average household size
HH_TOTAL Total Households
HH_1P Total 1-person households
HH_1PM 1-person households Male householder
HH_1PF 1-person households Female householder
HH_2MP Total 2-or-more person households
HH_2MPFAM Total 2-or-more person Family households
HH_2MPCOU Total 2-or-more person Married-couple family
HH_2MPU18 Total 2-or-more person Married-couple family  with own children under 18 years
HH_2MPNU18 Total 2-or-more person Married-couple family no own children under 18 years
HH_OTHFAM Total 2-or-more person Other families
HH_MNW Total Male householder, no wife present
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HH_MNWU18 Male householder, no wife present with own children under 18 years
HH_MNWNU18 Male householder, no wife present no own children under 18 years
HH_FNH Total Female householder, no husband present:
HH_FNHU18 Female householder, no husband present with own children under 18 years
HH_FNHNU18 Female householder, no husband present no own children under 18 years
HH_NONFAM Total Nonfamily households
HH_NONFAMM Nonfamily household Male householder
HH_NONFAMF Nonfamily household Female householder

FAM_TOTAL Total Families
FAM_POP Total Population in families
FAM_AVGSZ Average family size

HU_POP Total population in occupied housing units
HU_POPOWN Occupied housing units owner occupied
HU_POPRENT Occupied housing units renter occupied
HU_AVGSZ Total occupied housing units average household size—
HU_AVGSZO Occupied housing units average household size owner occupied
HU_AVGSZR Occupied housing units average household size renter occupied

Logrecno Statewide Census Record Number
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3 Map Viewer

3.1 Creating Maps with Map Viewer

Map Viewer is a feature of MapPro that allows an entire licensed area within a State to quickly be
displayed without having to enter an actual street address.  This can be very useful if you are dealing
with a tract of land which has no actual address or in rural areas where rural route addressing is used.
With Map Viewer, these maps can be quickly be displayed with just a few clicks of the mouse:

1. To start Map Viewer click the Map Viewer button on the Startup Button Bar.
2. If you have licensed maps in more than one State, a dialog box will be displayed so that the State
can be selected.  Select the desired State from the pop up menu.  Map Viewer will start and display a
county map for the entire licensed area within the State.  If you have licensed maps in only one State,
Map Viewer will start and immediately display a county map for the entire licensed area within the
State.
3. A Message window is displayed at the top of the screen with the message: "Select County from
Map".  At this point you have two different options:

(1) Move mouse pointer inside the county boundary of the county desired and click.
(2) Click on Zoom to Region button and select a region type and enter a location, then

proceed to step 5.
4. Map Viewer will zoom-in on the selected county and display a grid with the message: "Select Grid
Area from Map".  Move the mouse pointer inside the grid area that is closest to the area of interest
and click.
5. Map Viewer will now zoom-in on the area selected, display a Map Frame in the center of the area,
and display the size of the Map Frame in the Message Window.  The width of the Map Frame
displayed is determined by the Map Scale Default setting and the height of the Map Frame is
determined by the Paper Size setting.  Both of these settings may be changed in User Preferences.
6. Once the Map Frame is displayed, the size and position of the Map Frame may be changed.  You
can click and drag the Map Frame to adjust its position or the Set Map Center button may be used
to set its position.  Using the Zoom-In Tool will reveal more streets if there is not enough detail to
find the location to be mapped.  See Map Viewer Buttons for more details on adjusting the size and
position and changing the viewed map.
8. When you have finished setting the size and position of the Map Frame, select the Display Map
button. Note that the size and position of the Map Frame set at this point is just a preliminary setting.
Both size and position of the map can be changed at any time after the detailed map is displayed.

3.2 Map Viewer Buttons

 Unselect Objects - Unselects all previously selected objects.  This button is disabled when

no objects are selected.

 Select Objects - Used to select County, Grid Area, and move Map Frame.
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 Zoom to Region - Selecting Zoom to Region displays the following dialog. Allows user

quickly zoom to a City, Zip Code, Census Tract or Grid (if available).

 Zoom-In Tool - The Zoom-In Tool may be used to zoom-in on a certain area of the

displayed map that you would like to examine more closely.

To use Zoom-In Tool:
1. Click the Zoom-In button.
2. Move the mouse pointer to the center of the area you want to zoom in on.  Clicking the mouse
button then magnifies the area by a factor of two and the point where you clicked now becomes the
center of the map window.  You can repeat this procedure until you have the desired level of
enlargement.

OR

2. Draw a marquee around the area by dragging the Zoom-In pointer diagonally and release mouse
button.  The selected area enlarges to fill the map window.  The aspect ratio of the map window is not
changed however, so if you choose an area that has a very different shape from the window, you will
end up seeing a much wider or taller area of the map than you selected.

 Zoom-Out Tool - The Zoom-Out Tool may be used to zoom-out on a certain area of the

displayed map that you would like to see more of.

To use the Zoom-Out Tool:
1. Click the Zoom-Out button.
2. Move the mouse pointer to the center of the area you want to zoom out. Click the mouse and the
map size will increase by a  factor of two with the center of the map being at the point where you
clicked.  You can repeat this procedure as desired.

OR:

2. Draw a marquee by diagonally dragging the Zoom-Out tool across the window.  The area displayed
in the current map window then shrinks in size to fit inside the marquee area.
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 Grabber Tool - The Grabber Tool allows the displayed map to be moved in any direction

Moving map only affects the display and does not affect the map position when it is printed.

To reposition a map:
1. Select the Grabber Tool button.  The cursor displays as a hand when moved over the map window.
2. Click and hold down mouse button in an area of the map.  While holding down the mouse button,
drag the map in the desired direction.  When you release the mouse button, the map is redrawn in its
new location.

 Previous View - Displays the previous Map Viewer screen.

 Bigger Map - This button causes the Map Frame to increase in size by 10-20%.  The amount

of the increase varies with the size of the original frame.

 Set Map Center - When this button is selected, the center of the Map Frame is set at the

point in the map window where the left mouse button is clicked.

 Smaller Map - This button causes the Map Frame to decrease in size by 10-20%.  The

amount of the decrease varies with the size of the original frame.

 Display Map - After the size and position of the Map Frame has been set, selecting Display

Map causes the Location Map to be displayed.

 Exit Map Viewer - Exit Map Viewer without displaying a map.

 Map Viewer Help - Displays Map Viewer Help.
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4 Map Maker

4.1 Creating Maps with Map Maker

Map Maker is used to make maps when you have one or more known addresses to mapped.

To Create a Map with Map Maker:

1. Click on the New Map File button on the Startup Button Bar.
2. Click on Add button on the Map Point Data dialog.
3. Enter the Map Point address information and select the Arrow Type and size.
4. Repeat step 2 and 3 for any additional Map Points.
5. After after Map Point have been entered, select Done.
6. The Map Functions Buttons, the Map Tools Buttons, and the Main Menu are then displayed.
7. Select the map to display from the Map Functions Button Bar and then use the other Map
Functions, Tools, and Main Menu functions as needed.

4.2 Appraise-It Interface

MapPro has a complete Interface to Software for Real Estate Professionals' Appraise-It Software.  With
this Interface, information contained in a Appraise-It appraisal report may be extracted from the
report by MapPro.  This information includes all the data that would normally be manually entered on
the Map Point Data dialogs.  In order for the Appraise-It Interface to MapPro to work, certain
components are installed at the time of the MapPro installation which allows MapPro to be initiated
directly from the Appraise-It Tools Menu.  Appraise-It must exist on your system when MapPro is
installed.  If Appraise-It was installed after MapPro, perform a repair on the installation to install the
required components.

To initiate MapPro from Appraise-It, select MapPro from the Appraise-It Tools Menu.  MapPro will start
and automatically performs a New Map Data File operation with the default name for the Map Data
File being the same as the name of the report.  After the Map Data File is created,  MapPro retrieves
the information from the Appraise-It report and locates each of the property addresses just as if they
were entered from the Map Point Data dialog.  After all the addresses have been located the Map
Point Data dialog is displayed.  When MapPro is started via Appraise-It, the User Type is automatically
forced to Real Estate Appraiser regardless of which type is set in the User Preferences.  The arrow
Type for all Map Point are also automatically set to the correct type for the appraisal form being used
in Appraise-It.

If MapPro was previously initiated from Appraise-It from the same report, the Map Data File will
already exist. In this case you may use the same name or enter a new name. If you use the same
Map Data File, you may use the previous data or get new data from the Appraise-It report.

The Location and Flood Maps, as well as other information needed in the Appraise-It Report may be
sent back to Appraise-It. After any map has been displayed, an additional "Appraise-It" Menu item
appears on the MapPro Menu Bar.  This menu contains Update Appraise-It Report...  that
displays the following dialog:
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Click on each item you want to update in the Appraise-It report or click on Select All to quickly select
all the fields. Select OK and the Appraise-It report will be updated.  Appraise-It must be running with
the Report Name specified at the top of the Update Appraise-It Report dialog open in order for the
report to be successfully updated. Maps sent to Appraise-It should be saved in Windows Metafile
format (WMF) and are saved in the Appraise-It Image Directory. The file names of the map image files
sent to Appraise-It are the name of the report with "Location_Map" or "Flood_Map" appended to it.
When MapPro has completed the update process a message "All Information Sent to Appraise-It
- MapPro will Exit" is displayed.  The maps can then be viewed under Mapping and Sketch Addenda
on the Appraise-It Contents Menu.

4.3 ACI Report Interface

MapPro has a complete Interface to ACI's ACI Report Software.  With this Interface, information
contained in a ACI Report appraisal report may be sent to MapPro directly from the ACI Report
software.  This information includes all the data that would normally be manually entered on the
Map Point Data dialogs.  In order for the ACI Interface to MapPro to work, users must have
MapPro Version 8.3 or higher and must also have ACI Report Version 8.6.1 or higher.

To initiate MapPro from ACI Report, select MapPro from the ACI Report E-Services/Mapping Menu.
MapPro will start and  automatically performs a New Map Data File operation with the default name
for the Map Data File being the same as the name of the report.  After the Map Data File is created,
MapPro retrieves the information sent from the ACI report and locates each of the property addresses
just as if they were entered from the Map Point Data dialog.  After all the addresses have been located
the Map Point Data dialog is displayed.  When MapPro is started via ACI Report, the User Type is
automatically forced to Real Estate Appraiser regardless of which type is set in the
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User Preferences.  The arrow Type for all Map Point are also automatically set to the correct type as
used in ACI Report.

If MapPro was previously initiated from ACI Report from the same report, the Map Data File will
already exist. In this case you may use the same name or enter a new name. If you use the same
Map Data File, you may use the previous data or get new data from ACI Report.

The Location and Flood Maps, as well as other information needed in the ACI Report may be sent back
to ACI Report. After any map has been displayed, an additional "ACI Report" Menu item appears on
the MapPro Menu Bar.  This menu contains Update ACI Report...  that displays the following
dialog:

Click on each item you want to update in ACI Report or click on Select All to quickly select all the
fields. Select OK and the report will be updated.   Maps sent to ACI Report should be saved in
Windows Metafile format (WMF) to insure the highest quality.  When MapPro has completed the
update process a message "All Information Sent to ACI Report - MapPro will Exit." is displayed.

4.4 ClickForms Interface

MapPro has a complete Interface to Bradford Technologies' ClickFORMS Software.  With this Interface,
information contained in a ClickFORMS appraisal report may be sent to MapPro directly from the
ClickFORMS software.  This information includes all the data that would normally be manually entered
on the Map Point Data dialogs.  In order for the ClickFORMS Interface to MapPro to work, users
must have ClickFORMS Version 3.0.0 or higher.
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To initiate MapPro from ClickFORMS, select MapPro from the ClickFORMS Tools Menu.  MapPro will
start and  automatically performs a New Map Data File operation with the default name for the Map
Data File being the same as the name of the report.  After the Map Data File is created,  MapPro
retrieves the information sent from the ClickFORMS report and locates each of the property addresses
just as if they were entered from the Map Point Data dialog.  After all the addresses have been located
the Map Point Data dialog is displayed.  When MapPro is started via ClickFORMS, the User Type is
automatically forced to Real Estate Appraiser regardless of which type is set in the
User Preferences.  The arrow Type for all Map Point are also automatically set to the correct type as
used in ClickFORMS.

If MapPro was previously initiated from ClickFORMS from the same report, the Map Data File will
already exist. In this case you may use the same name or enter a new name. If you use the same
Map Data File, you may use the previous data or get new data from ACI Report.

The Location and Flood Maps, as well as other information needed in the ClickFORMS Report may be
sent back to ClickFORMS. After any map has been displayed, an additional "ClickFORMS" Menu item
appears on the MapPro Menu Bar.  This menu contains Update ClickFORMS...  that displays the
following dialog:

Click on each item you want to update in ClickFORMS or click on Select All to quickly select all the
fields. Select OK and the report will be updated.   Maps sent to ClickFORMS should be saved in JPEG
format. This format is specified by selected "JPEG" on the Image Output Preferences section of
User Preferences.  When MapPro has completed the update process a message "All Information
Sent to ClickFORMS - MapPro will Exit." is displayed.
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4.5 Using Google Earth Pro with MapPro

If Google Earth Pro is installed on your PC, when the Aerial Map button is pressed MapPro will start
Google Earth Pro. MapPro creates a file for use with Google Earth Pro and places this file in the "Data"
folder under the MapPro installation folder. This folder is normally C:\MapPro\Data. This file will have
the same name as the MapPro map data file name with "_MapPro.tab" appended to the name.
Therefore if your map file name was "123456.mpd" the file created for importing into Google will be
"123456_MapPro.tab".  After Google Earth starts, go to the File Menu, select Import and find the file
created by MapPro.
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5 Menus & Buttons

5.1 Main Menu

The MapPro Main Menu contains the following list of  menu items.  Each of the Main Menu items
contains one or more sub-menu items that may be selected. The MapPro software disables or removes
items from the Main Menu and its sub-menus when prerequisites for the specific menu item have not
been performed or the Menu is not applicable. The disabled menu items appear grayed or lighter in
color when they are disabled.

File Edit Map Options Setup Help

File Menu
New Map Data File - Causes a new Map Maker data file to be created.  A date coded file
name, using year, month, day and a sequential number starting at 01 thru 99, is displayed as
the default file name in the New Map Data File dialog.  You may either use this name or enter
your own file name.

Open Map Data File - Displays a dialog where a previously created Map Data File may again
be opened.  Select the desired Map Data File and select Open or double-click on the file name.

Close Map Data File - Closes the currently open Map Data File.

Save Map Data File -  Forces currently open map data file to be saved.  It is normally not
necessary to perform this operation because the MapPro software automatically saves the
current map data file whenever the data changes or after a map is displayed or altered in any
way.

Save Map Data File As... - In some instances you may want to create maps that have much
the same data as a previous map you have created.  In this instance, open the map data file
that contains the similar information and then select Save Map Data File As... and enter the
name of the new map data file.

Print - Initiates a print operation. See Print Map.

User Preferences - Displays current User Preferences and allows them to be changed. See
User Preferences.

Directory Preferences - Displays current Directory Preferences and allows them to be
changed. See Directory Preferences.

Exit MapPro - Exits MapPro

1. ????????.MPD - The File Menu contains the names of the four most recently created or
opened map data files.  Selecting one of these four menu items performs
the same operation as selecting Open Map Data File and then opening
one of these four files.  These menu items simply provide a faster way to
get to your most recently used files.  After selecting one of these four file
names, the Map Point Data dialog is automatically displayed so that the
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Map Points may be reviewed prior to displaying a map.
2. ????????.MPD
3. ????????.MPD
4. ????????.MPD

Edit Menu
Undo - Cancels the previous edit operation.

Copy Map Window / Copy - If no objects are currently selected this Menu Item is "Copy
Map Window" which copies the currently active Map Window to the Clipboard. If an object is
selected this Menu Item is "Copy" which copies the selected object(s) to the Windows
Clipboard.

Paste - Pastes the contents of the Windows Clipboard into the Cosmetic Layer of the Map.

Cut - Deletes the currently selected and editable text and copies the selected object(s) to the
Windows Clipboard.

Clear - Deletes the currently selected and editable text.

Unselect All - Unselects any selected objects.

Map Menu
Set Map Display Scale - Allows the map scale (width) of the displayed map to be changed.
This menu item is disabled if Dynamic Map Scaling is enabled.   The Map Scale displayed is the
current map scale. Enter the new desired value.

Disable Dynamic Map Scaling / Enable Dynamic Map Scaling - When Map Maker displays
a map it dynamically scales and centers the map based upon the location of all the Map Points
that have been entered.  There may be an occasion when you want to adjust the position and
map scale manually so you can show some feature on the map that is not shown.  When
Disable Dynamic Map Scaling is selected this dynamic scaling feature is turned off, the Set
Map Display Scale menu item is enabled, and the Disable Dynamic Map Scaling menu
item changes to Enable Dynamic Map Scaling.  The map scale and position may then be
manually set.

Set Map Distance Units - Allows the current map distance measurement units to be changed.
Default is Miles. Yards, Feet, Kilometers and Meters may be selected.

Display Cursor Location / Display Zoom - Normally when a map is displayed the Zoom or
map scale is displayed in the lower left corner of the map window.  When Display Cursor
Location is selected, the longitude and latitude at the location of the mouse pointer is
displayed in the lower left corner of the map window.  The menu item is then changed to
Display Zoom (Map Scale) to display the map scale again.

Save Window As... - Allows the map window to be saved in a Image File. The Save Window
As dialog allows you to specify the Image Size.

Same as Window - The default Width and Height of the image are automatically
displayed.  When you choose this setting, the image is saved with the current
dimensions.
Custom Size - When you want to make the image larger or smaller, scale the image
by either entering the width or height or resize the window manually.  When you
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change either the height or the width, MapInfo changes the other dimension to
preserve the image's proportions.
When the Save button is pressed the Save Window to File dialog where you can

specify the File Name, Path, and Save as type.

Options Menu
Show Drawing Tools Buttons/Hide Drawing Tools Buttons - Shows or Hides the
Drawing Tools Buttons

Edit UserMap Layer/Edit Cosmetic Layer - MapPro allows users to create their own private
map layer that can be used for new streets or other map features not contained in the MapPro's
Maps.  This UserMap layer resides in the Data Directory Path specified in
Directory Preferences.  In order to add a map object to the UserMap Layer, select Edit
UserMap Layer menu item on the Options Menu must be selected after a map is displayed.
After the UserMap editing has been enabled "Editing: UserMap" in the bar at the bottom of the
map window.  The Drawing Tools may then be used add streets or other map features. Map
objects added to the UserMap layer will be saved when Edit Cosmetic Layer is selected from
the Options Menu or the Map Data File is closed.

Hide UserMap Layer/Show UserMap Layer - When any map is displayed the UserMap layer
is automatically displayed to show any additional map features you have added.  If you wish
hide the UserMap layer you may do so by selecting Hide UserMap Layer.  In order to display
the UserMap layer again select Show UserMap Layer.

Clear UserMap Layer - Clears all map objects and data for the entire UserMap Layer.  A
warning message is displayed prior to the operation being performed.  USE THIS WITH
EXTREME CAUTION, you may permanently destroy a great deal of work that has been done.

Display Streets on Aerials - This menu item will only be enabled if the optional Infrared
Aerials, available for some areas, have been purchased.  Checking this menu item causes the
street maps to be overlayed on top of the aerial images.

Setup Menu
Company Info - Displays your Company Info and allows any of the information to be changed.
This information is sent to the MapPro Server every time you select Update MapPro License.

Reload Licensed Maps - Allows the licensed map files to be reloaded from CD or downloaded
Zip File.  This should normally not be necessary unless these files were inadvertently deleted or
they have been corrupted in some way.  If maps were previously loaded you will be asked if you
wish to load "All" or just "New" map files. If you suspect a file might be corrupt, select "All".

Update MapPro License - Used to update your MapPro License when your licensed counties
have changed, your company info has changed or you have recently made a payment.

Help Menu
Contents - Displays the Help Contents for MapPro Help.

Search for Help On... - Allows you to search for Help by entering or selecting a specific
keyword.
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How to use Help - A standard Windows Help Tutorial that contains help on how to use Help.

About MapPro... - Displays a dialog with Software and Map Versions, Serial Number and
Licensed Options.

Census Demographic Profiles... - Displays links for any state wide demographic profiles that
have been installed.

Web Site Links... - Displays links to MapPro's Web Sites.

5.2 Startup Button Bar

New Map Data File
Selecting the New Map File button on the Startup or Map Functions Button Bars or selecting New Map
Data File from the File Menu causes a new Map Maker data file to be created.  A date coded file name,
using year, month, day and a sequential number starting at 01 thru 99, is displayed as the default file
name in the New Map Data File dialog.  You may either use this name or enter your own file name.
The default File Type for Map Data Files is "mpd" (MapPro Data).  These files are save in the Data
Directory Path which is normally "C:\MapPro\Data".  DO NOT change this path here. Select
Directory Preferences if you would like these files saved in a different location. After the Map Data
File has been created the Map Point Data dialog is displayed where Map Points for the Map Maker
Map can be entered.  Once the file has been created, Open Map Data File may be selected to reload
all saved information relevant to a map.
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Open Map Data File
Selecting the Open Map File button on the Startup or Map Functions Button Bars or selecting Open
Map Data File from the File Menu displays a dialog where a previously created Map Data File may
again be opened.  Select the desired Map Data File and select Open or double-click on the file name.
When the file is opened, the Map Point Data dialog is automatically displayed so that the Map Points
may be reviewed prior to displaying a map.

Map Viewer
Map Viewer is a feature of MapPro that allows an area within a licensed counties to quickly be
displayed without having to enter an actual street address.  This can be very useful if you are dealing
with a tract of land which has no actual address or in rural areas where rural route addressing is used.
With Map Viewer, these maps can be quickly be displayed with just a few clicks of the mouse. Click
here for more information on the use of Map Viewer

Database Utility
The Database Utility is a MapPro feature that provides users the capability to create databases or
import existing Microsoft Access or dBase databases.  These databases may then be geocoded (the
process of assigning X and Y coordinates to the database records so they can be displayed as objects
on a map) and then added as layers to the map.   Click here for more information on the use of
Database Utility

Arrow Maker
The Arrow Maker is a utility that allows users to create or modify arrows that are used on the maps in
MapPro.  Click here for more information on the use of Arrow Maker

Exit MapPro
Exit MapPro terminates execution of MapPro.

Help
Displays MapPro Help

5.3 Map Functions Buttons

New Map Data File
Selecting the New Map File button on the Startup or Map Functions Button Bars or selecting New Map
Data File from the File Menu causes a new Map Maker data file to be created.  A date coded file name,
using year, month, day and a sequential number starting at 01 thru 99, is displayed as the default file
name in the New Map Data File dialog.  You may either use this name or enter your own file name.
The default File Type for Map Data Files is "mpd" (MapPro Data).  These files are save in the Data
Directory Path which is normally "C:\MapPro\Data".  DO NOT change this path here. Select



Menus & Buttons 47

Copyright © 1994-2020 MapPro, Inc.

Directory Preferences if you would like these files saved in a different location. After the Map Data
File has been created the Map Point Data dialog is displayed where Map Points for the Map Maker
Map can be entered.  Once the file has been created, Open Map Data File may be selected to reload
all saved information relevant to a map.

Open Map Data File
Selecting the Open Map File button on the Startup or Map Functions Button Bars or selecting Open
Map Data File from the File Menu displays a dialog where a previously created Map Data File may
again be opened.  Select the desired Map Data File and select Open or double-click on the file name.
When the file is opened, the Map Point Data dialog is automatically displayed so that the Map Points
may be reviewed prior to displaying a map.

Close Map Data File
Closes a open Map Data File in Map Maker or closes a Map Viewer session and displays the
Startup Buttons.

Exit MapPro
Saves any unsaved file and exits MapPro.

Map Point Data
The Map Point Data is the primary dialog in MapPro where property addresses are added, changed or
removed.  The dialog is displayed every time a Map Data File is created or opened or when the Map
Point Data button is selected.  From this dialog Map Points, either containing an actual street address
or just a description, may be added, changed, or removed from the map.  Map Points may also be
added from a User Database or added to a User Database.  There is no defined limit on the number of
Map Points that may be added.  There is of course a practical limit though, since too many arrows on
a map could result in most of the map detail being obscured by the arrows themselves.  For details on
this dialog see Map Point Data.

Location Map
When the Location Map button is pressed, MapPro selects the appropriate layers for the map, creates
the arrows or icons for the map points (if being displayed from Map Maker), dynamically scales and
centers the map, labels all the information on the various layers and then displays the map.  The
County Location Map is also displayed but is hidden behind the maximized Location Map. Restoring the
Location Map window to its normal size will reveal the County Location Map.  The Location Map is
automatically displayed when the Display Map button is clicked in Map Viewer. See Map Layers
for information on all the map layers contained on the Location Map.

Flood Map
When the Flood Map button is pressed, MapPro selects the appropriate layers for the map, creates the
arrows or icons for the map points (if being displayed from Map Maker), dynamically scales and
centers the map, labels all the information on the various layers and then displays the map.  The
County Location Map is also displayed but is hidden behind the maximized Flood Map. Restoring the
Flood Map window to its normal size will reveal the County Location Map.  See Map Layers for
information on all the map layers contained on the Flood Map.

During the process of displaying the Flood Map from Map Maker, the flood zone information for the
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first map point (considered to be the Subject property) is checked.  If it is determined that the Subject
property is within 250 ft. of the edge of a 100 yr. Flood Zone a message stating this fact will be
displayed.  Due to the positional accuracy of the Street Maps and Flood Maps, the actual location of
the property in relation to the 100 yr. flood zone could be in error by up to 250 ft. FEMA recommends
that additional research must be done in order to make actual flood zone determination.  It is
recommended that the location shown on the Flood Map be compared with the location on FEMA
paper FIRMs or that a survey may be necessary to make actual flood zone determination.  A red 250
ft. radius circle is displayed on the Flood Map to show the possible margin of error.

Hazards Map
This button will be displayed if you have subscribed to the Hazards Map option.  Hazards Map contains
known potential environmental risks within a one mile radius of the subject property.  The subject
property is considered to be the first property in Map Point Data whether it is called subject or not.
This data is a compilation of information from EPA and state databases.  The American Society for
Testing Materials (ASTM) has established a radius standard for each type of potential hazard.  The
table below contains the radii formats established by ASTM:

Hazard Type Radius(Mi.)
NPL, CORRACTS, SPL     1.00
RCRIS_TSD, CERCLIS, SWLF, LUST     0.50
NFRAP, RCRIS_LG, RCRIS_SG, UST, AST     0.125
ERNS, ST-SPILL     0.05

Only the hazards that apply to the above standard are displayed.  There may be many other potential
hazards in the one mile radius from the subject property.  See Environmental Hazard Types for
details on each type of environmental hazard.  See Map Layers for information on all the map layers
contained on the Hazards Map.

Aerial Map
This button will be displayed if MapPro detects that Google Earth Pro is installed on your PC or if you
have purchased optional Aerial Images (available for some metro areas in Texas and for Puerto Rico).
If Google Earth Pro is installed on your PC, when the Aerial Map button is pressed MapPro will start
Google Earth Pro. Then go to the File Menu in Google Earth Pro and select Import. MapPro creates a
file for use with Google Earth Pro and places this file in the Data folder under the MapPro installation
folder which is normally C:\MapPro.  See Using Google Earth Pro with MapPro for details on
importing MapPro addresses into Google Earth Pro.  When the Aerial Map button is pressed and you
have purchased aerial image data, the aerial image for the area is displayed.  The Aerial must have
been previously loaded on to your system   When the Aerial Map button is selected, the Aerial Image
Path setting in Directory Preferences is examined to determine the location of the images.  If the
image file for the displayed area cannot be located the operation is aborted.  See Map Layers for
information on all the map layers contained on the Aerial Map.

User Database Layer
Any number of User Database Layers may be added to any Map Viewer or Map Maker Map.  These
User Database Layers may be created using the Database Utility. option.  Default Database Layers
may be specified in Directory Preferences in you wish to always display certain database layers on
all Map Viewer and Map Maker maps.  The User Database Layer settings for each map are saved in
the Data Directory with the same file name as the Map Data File but has a ".MDB" file extension.
"Default.MDB" contains the Default Database Layers and exists only if defaults have been specified.
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Print Map
Print Map is one of most important functions in MapPro. Print Map allows maps to be not only maps to
be printed but also allows maps to sent to image files for importing into other applications.
User Preferences contains settings for the printer and image output and users should make sure
these settings are correct before using the Print Map function. See Print Map for detailed information
on printing maps.

Rotate Arrow
When the map is displayed, Map Maker will normally place the arrows so they do not overlap each
other. But sometimes due to the close proximity of the arrows one arrow may be positioned partially
on top of another.  Rotate Arrow allows any arrow to be rotated clockwise 90, 180, or 270 degrees.

To rotate an arrow:
1. Select the Rotate Arrow button.  A dialog box similar to the one below will be displayed.

2. Select the arrow to rotate from the list and select the clockwise rotation desired.
3. The selected arrow will be rotated and the map will be redisplayed.

Move Arrow
When the map is displayed, the location for the placement of the arrows is determined by addressing
information associated with each street segment.  Occasionally you may find that an arrow has not
been placed in exactly the right location due to some inaccuracy in the addressing.  If this occurs, you
may move the location of the arrow with the Move Arrow Tool.

To move an arrow:
1. Select the Move Arrow button.
2. Move mouse pointer to the exact location that the arrow should be located and click. Use the
Zoom-In Tool if needed to enlarge the map to permit more accurate placement.
3. The following dialog will then be displayed. Select the arrow to move.
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4. The arrow is moved and the map is redisplayed.

Place Arrow
The Place Arrow Tool can be used on both Map Viewer and Map Maker maps.  Since Map Viewer
Maps do not contain any arrows no Map Point Data associated with them, using the Place Arrow
Tool on a Map Viewer map causes it to transition from a Map Viewer map to a Map Maker map.
When the arrow is placed on the Map Viewer map, a Map Data File needs to be created to save
the Map Point Data associated with the placed arrow.  This works just as if a New Map File
function was performed right in the middle of the Place Arrow.

To place an arrow in a Map Viewer map:

1. Select Place Arrow Tool button.
2. Move mouse pointer to the exact location that the arrow should be located and click the mouse
button... Use the Zoom-In Tool if needed to enlarge the map to permit more accurate placement.
3. Enter a new Map Data File name and the dialog below will be displayed.

4. Enter an Address or Description and select an Arrow Type. Note that the City, Zip, County, and Grid



Menus & Buttons 51

Copyright © 1994-2020 MapPro, Inc.

get automatically filled with the correct information.  If the Map Point is not within a city boundary or
no grid is available, these fields will be left blank.
5. The Map Viewer map now becomes a Map Maker map. The map is dynamically scaled and
centered with the map scale set to the Min. Map Scale value in User Preferences.  Note the title bar
of the map window now displays "Map Maker" and the Map Data File name.  Note also that the Map
Point Data, Rotate Arrow, and Move Arrow buttons are now enabled.

In Map Maker the Place Arrow Tool serves two purposes.
First, when the Map Point Data is entered, the map points are located using the address, zip code, and
sometimes the grid.  Sometimes, especially in fast growing areas, a new street may exist that is not
on the map. If the map point location cannot be found, a message will be displayed informing you that
the arrow will have to be manually placed.
Secondly, after all the arrows for the data entered in Map Point Data have been placed on the map,
either automatically or manually, the Place Arrow Tool may be used to place an arrow on the map and
then enter the address or description.

To place an arrow for a Map Point that was not found in a Map Maker map:

1. Select Place Arrow Tool button.
2. Move mouse pointer to the exact location that the arrow should be located and click the mouse
button... Use the Zoom-In Tool if needed to enlarge the map to permit more accurate placement.
3. A dialog will then be displayed listing all the Map Points not yet placed on the map. Select a Map
Point from the list and select OK.
4. The selected Arrow is placed on the map and the map is redisplayed.

To place an arrow for new Map Point in a Map Maker map, follow the same procedure as used for
placing an arrow in a Map Viewer map.  Since a Map Maker map already has a Map Data File
associated with it, step 3 will be eliminated.

Help
Displays MapPro Help.

5.3.1 Map Point Data

The Map Point Data is the primary dialog in MapPro where property addresses are added, changed or
removed.  The dialog is displayed every time a Map Data File is created or opened or when the Map
Point Data button is selected.  From this dialog Map Points, either containing an actual street address
or just a description, may be added, changed, or removed from the map.  Map Points may also be
added from a User Database or added to a User Database.  There is no defined limit on the number of
Map Points that may be added.  There is of course a practical limit though, since too many arrows on
a map could result in most of the map detail being obscured by the arrows themselves.
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Adding Map Points
To add an address (which MapPro refers to as a Map Point) select the Add button on the Map Point Data dialog.
The following dialog will then be displayed.

1. Enter a street address, a street intersection, or a description in the Address/Description field.  If
an street address is entered, make sure it is a full street address containing both and address
number and a street name. Include any directional prefix or suffix (such as N, S, E, W) to the street
name. Also include any suffix (such as Dr, Ave, Blvd, Cir, Place, etc.) to the street name.  Do not
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include any punctuation (such as . or ,) in any part of the street name.  The program contains an
abbreviation table that will take care of abbreviations for common street prefixes and suffixes,
therefore you may spell out the prefix or suffix and the street name will still be found.

A street intersection may be entered by separating two street names with " && ". (i.e. "Chimney
Rock Rd && Richmond Ave")  When a street intersection is used, the streets must cross one another.
The intersection will not be found if one street "T"s into another.

If Address/Description field contains a Description make sure the Description Check Box below this
field is checked so the software does not try to locate it.

2. Select the arrow type from the Type pop up menu. Types that end in a # sign will result in the #
being replaced with a number starting at 1 and will be incremented each time this Type is selected.
Additional Types may be added to this list. See Arrow Maker for details.
3. Style contains the Default Property Symbol style selected in User Preferences. This default style
may be changed for any Map Point if desired.
4. Enter the city in the City field. This field is optional and may be left blank. MapPro will automatically
fill the City name field with either the Post Office name or the City name.
5. Enter the zip code in the Zip field.  If you don't know the zip code the field can be left blank.  If the
Zip field is left blank the County, ST where property is located must be selected in step 6.
6. The County,ST normally will contain "(All counties)" which is the default selected in
User Preferences. If this field displays an actual county name rather than "(All Counties)" or you did
not enter a Zip in step 5, you must select the correct county where the property is located. MapPro
will find the correct county if a Zip is entered and the County,ST field contains "(All counties)"
7. The Grid field exists only in some States and Counties. This field is a local map book page and
block letter.  This field is only used if the property address can not be located.  In this case the map
point is set an approximate location at the center of the grid entered.  Enter the map grid location
where the map point is located into the Grid field if you have this information.  This field is also
optional.
8. The Find Location By... Address/Coordinates selection defaults to Address. In this mode the
address information entered in the fields above is used to find the location of an address on the map.
If a user already has the earth coordinates (ie. latitude & longitude) of a property, the Coordinates
radio button may be selected.  When Coordinates is selected a decimal latitude and longitude may be
entered or the Enter DMS button may be selected to enter the coordinates in degrees, minutes, and
seconds as shown below.

9. When OK is selected, the Map Point is located based upon the information entered. If the entered
address is found in the entered zip code, city, and grid the Map Point information is added to the list
box fields in Map Point Data dialog. If the exact address can not be found, MapPro analyses the
entered information in order to find possible matches. If possible matches are found a dialog similar to
the one below is displayed:
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Possible matches with Street Address, City, Zip Code and County are displayed in the popup menu.
User must either select an address from this list and click Accept Match or click Not a Match if none of
the possible matches are correct.  In this case the Advanced Search dialog will be displayed where
several different options exist to find the specified address.  See Advanced Search for details.

Also See: Adding Map Points from a Database and Adding Map Points to a Database

Changing Map Points
To Change a Map Point, select the Address/Description field on the Map Point Data dialog for the Map
Point you wish to change. Then select the Change button.  The Change Map Point dialog is displayed.
Make the needed changes to the Map Point and select OK.  If the Map Point was previously located
and the Address, Zip, or Grid was changed, the following dialog will be displayed and the Old Address
and New Address are displayed in a Message window at the bottom of the screen.

If Yes is selected, the new address is located in the same manner as for Adding Map Points above.
If No is selected, the modified fields are changed but the new address will not be located.

If the arrow for the Map Point was moved or manually placed the following dialog will be displayed:
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If Yes is selected, the current position of the arrow is saved and the modified fields are changed.  If
No is selected, the new address is located in the same manner as for Adding Map Points above.

Removing Map Points
To Remove a Map Point, select the Address/Description field on the Map Point Data dialog for the Map
Point you wish to remove. Then select the Remove button. A dialog verifying this operation is
displayed.

Changing the Order of Map Points
After Map Points have been added to the Map Point Data, the order which they appear in the list
may be changed.  This may be accomplished by selecting the Address/Description field of the Map
Point to move in the list.  Then select the Up or Down button depending upon which way you want to
move the Map Point in the list.

5.3.2 Advanced Search

When an exact match can not be found on a address and zip code that has entered the following
Advanced Search dialog is displayed:
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Below is a list of tips for finding street addresses with the Program's response, followed by the
suggested action:

1. Street Name not found.
Program Response: Advanced search dialog displayed.   Any directional prefix to street and/or
directional suffix or street suffix of less than 4 character is removed from entered name to
create a base name for the street.  Advanced Search dialog displays a list of street names that
closely match the base name of the street.  If the entered zip code crosses county boundaries, a
message "Additional counties remain to be searched" is displayed at the bottom of the
Advanced search dialog.

Suggested Action:  Look at the list of displayed names, if the street name you are looking for
appears in the list click on the street name/zip code in the list and then click on Select. If the
list is empty or you do not see a name that you feel matches the street you are looking for there
are several different options available to you:
A.  If you think the street might be in another zip code click the "All Zip Codes" check box and
then click Search.  All zip codes in the county will be searched for the street
name entered with a list of close matches and their zip codes displayed.
B.  If you feel that you may have misspelled the street name, correct the spelling and click
Search.
C.  If you want to match on only a portion of the name when you are not sure of the spelling or
other reasons, type in only a portion of the name, then click on "Containing", then click on
Search.  For example: If you originally entered the street name "N Bayou Park Dr". Advanced
Search will display "Bayou Park" but you might want to search for all streets containing "Bayou".
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You can do this both with "All Zip Codes" checked or unchecked.
D. If additional counties remain to be searched and you think the property is in  another county,
click Cancel and the next county will be searched.
E.  If you click Cancel with no counties remaining to be searched the location of the property
will be placed either at the center of the grid if it was provided or the center of the zip code if no
grid was provided.

2. Street Address not found in entered zip code.
Program Response: Find dialog displayed with error "Boundary not found." List of zip codes
containing address displayed.

Suggested Action: Select correct zip code from list. Occasionally an address will be found in a
zip code other than the correct zip code.  This mainly occurs when the entered address is on or
very near a zip code boundary.  Unfortunately the only way to get the arrow to be displayed
correctly in this situation is to select the wrong zip code.

3. Address not found.
Program Response: Find dialog displayed with error "Address number not found."  List of
available address ranges displayed.
Suggested Action: Make sure the street suffix is correct.  Many times streets with the same
base name but a different suffix exist in the same zip code. (i.e. Park Ln, Park Dr, & Park Ct)  A
good indicator that this might be the case is if the available ranges are no where close to
address number entered.  Address ranges of  "0" in the list indicates a street segment that has
no addressing assigned.  This will occur frequently on rural roads.  Sometimes a new street
segment has been added to a street that is not in the map or a existing map segment has been
recently addressed. If there is an address range fairly close to the address number entered,
select that address range. One of two different messages will then be displayed depending upon
whether or not a Grid was entered. If no Grid entered: "Exact street address NOT found! Find
using Closest Address or Manually place location later?".  If Grid entered: "Exact street address
NOT found! Find using Closest Address or Find approximate location using Grid?".  Select your
preference.

4. City different than entered City
Program Response: A message is displayed informing you that the actual city where the Map
Point was found is different than the City that was entered.
Suggested Action:  It is up to you to decide if you want to change the City or not.  Many
times the mailing address city name is different than the actual city boundary that a Map Point is
within.

5. Grid different than entered Grid
Program Response: A message is displayed informing you that the actual grid where the Map
Point was found is different than the Grid that was entered.
Suggested Action:  It is up to you to decide if you want to change the Grid or not.  The grid
used by MapPro may not be precisely aligned with the paper map grid.

5.3.3 Adding Map Points from a Database

Map Points may be added to the Map Point Data from a selected database.  This feature makes it easy
to add Map Points that have already been geocoded and also eliminates having to type the
information in again.

Add from Database: To add Map Points from a database, select the Add from DB button on the
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Map Point Data dialog.  A File Open dialog will be displayed. Select the database where Map Points
will be added from.  The Map Point Data dialog is then removed from the screen, the database is
opened and the following message will be displayed:

Select the desired records by clicking on the box(es) on the left side of the window. To select multiple
records hold the Shift key down while selecting.  Use the scroll bars as needed to view records further
down in the database. Click the Add Selection button when all the desired records are selected.  If
you wish to abort the selection process, click the Add Selection button with no records selected.  All
currently selected records may be unselected by clicking on the Unselect Objects button.

After the Add Selection button is clicked, an Add Map Point dialog is displayed for each of the selected
records.  Change the arrow Type for each as needed.  If the database records were previously
geocoded, the latitude and longitude contained in the database record are used.  If the record has not
been previously geocoded, the Map Point is located in the same manner as a normal Add Map Point
operation.  See Advanced Search for additional information.  Selecting Cancel on the Add Point
dialog will cancel or bypass the adding of the currently displayed Map Point.  When all the selected
records have been processed the database is closed and the Map Point Data dialog is redisplayed.

5.3.4 Adding Map Points to a Database

A selected Map Point may be added to selected database.  This feature makes it easy to add records
to a database without having to retype the information and then geocode the point in the Database
Utility.

Add Map Point to Database: To add a Map Point to a database, select a Map Point from the
Address/Description field in the Map Point Data dialog.  Then select the Add to DB button.  A File
Open dialog will be displayed. Select the database where the Map Point is to be added.  The database
is opened, the Map Point is added to the database using the last symbol used when geocoding was
performed in the selected database or the default symbol if no geocoding was ever performed on the
selected database.  A message is displayed confirming the Map Point was added.

5.3.5 Map Layers

Maps in MapPro contain many layers of information.  These layers are arranged in a way so that
objects of one layer do not obscure the view of objects of another layer.  Each type of map in MapPro
contains certain unique layers of information not contained on the other maps.  Below is a list of the
map layers contained on each type of map.

Location Map Layers
The Location Map contains 16 different layers of information:

1. Cosmetic Layer - Where all map objects you create such as lines, symbols, polygons, and text are
placed.
2. Arrow2 - Where the text for the Map Maker arrows is placed.
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3. Arrow - Where the Map Maker arrows are placed.
4. Highways  - Contains all Limited Access Roads, US highways and state highways.
5. Major - Contains major city streets and major county roads.
6. Strt - Contains all the streets and roads of any type. All addressing information is contained in this
layer.

Any User Database Layers are inserted here.

7. UserMap - Contains user drawn streets or other info.
8. RR - Contains all railroads.
9. Watrmin - Contains minor streams, lakes, and ponds.
11. Pnts - Contains points of interest including schools, fire station, police stations, hospitals, post
offices, etc.
11. Watrmaj - Contains major rivers, bayous, and creeks.
12. Areas - Contains areas such as airports, shopping centers, colleges, major parks, subdivision
names, etc.
13. Cities - Contains City boundaries.
14. Ct - Contains census tract boundaries and demographics.
15. Zip - Contains Zip Code boundaries.
16. Counties - Contains County boundaries.

Flood Map Layers
The Flood Map contains 16 different layers of information:

1. Cosmetic Layer - Where all map objects you create such as lines, symbols, polygons, and text are
placed.
2. Arrow2 - Where the text for the Map Maker arrows is placed.
3. Arrow - Where the Map Maker arrows are placed.
4. Fldrad - Where the 250 ft. radius circle around the first map point or Subject property is placed.
5. Highways  - Contains all Limited Access Roads, US highways and state highways.
6. Major - Contains major city streets and major county roads.
7. Strt - Contains all the streets and roads of any type. All addressing information is contained in this
layer.

Any User Database Layers are inserted here.

8. UserMap - Contains user drawn streets or other info.
9. RR - Contains all railroads.
10. Watrmin - Contains minor streams, lakes, and ponds.
11. Pnts - Contains points of interest including schools, fire station, police stations, hospitals, post
offices, etc.
12. Watrmaj - Contains major rivers, bayous, and creeks.
13. Areas - Contains areas such as airports, shopping centers, colleges, major parks, subdivision
names, etc.
14. Cities - Contains City boundaries.
15. Flood - Contains the FEMA flood hazard map.
16. Counties - Contains County boundaries.

Hazards Map Layers
The Hazards Map contains 16 different layers of information:

1. Cosmetic Layer - Where all map objects you create such as lines, symbols, polygons, and text are
placed.



MapPro Help60

Copyright © 1994-2020 MapPro, Inc.

2. Arrow2 - Where the text for the Map Maker arrows is placed.
3. Arrow - Where the Map Maker arrows are placed.
4. Radii - Where the .05, .25, .5, and 1 Mi. radius circles around the first map point or Subject
property are placed.
5. Hazard - Contains the environmental hazards.
6. Highways - Contains all limited access highways, US highways and primary state highways.
7. Major - Contains secondary state highways, major city streets and major county roads.
8. Strt - Contains all the streets and roads of any type. All addressing information is contained in this
layer.

Any User Database Layers are inserted here.

9. UserMap - Contains user drawn streets or other info.
10. RR - Contains all railroads.
11. Watrmin - Contains minor streams, lakes, and ponds.
12. Pnts - Contains points of interest including schools, fire station, police stations, hospitals, post
offices, etc.
13. Watrmaj - Contains major rivers, bayous, and creeks.
14. Areas - Contains areas such as airports, shopping centers, colleges, major parks, subdivision
names, etc.
15. Cities - Contains City boundaries.
16. Counties - Contains County boundaries.

Aerial Map Layers
The Aerial Map contains x layers of information:

1. Cosmetic Layer - Where all map objects you create such as lines, symbols, polygons, and text are
placed.
2. Arrow2 - Where the text for the Map Maker arrows is placed.
3. Arrow - Where the Map Maker arrows are placed.
4. Major - Contains secondary state highways, major city streets and major county roads. (if Display
Streets on Aerial from Option Menu selected)

Any User Database Layers are inserted here.

5. Aerial Image.
6. Doqq - Grid containing information telling MapPro which aerial to display.
7. Counties - Contains County boundaries.

5.3.6 User Database Layer

To Add a User Database Layer:
1. Click on the User Database Layer button.  A dialog similar to the on shown below will be
displayed.  If Default Database Layers have been specified or User Database Layers were previously
added to the current Map Data File they will appear in the list box.
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2. To add a database layer click on the Add button. Any databases that reside in the Database
Directory Path (see Directory Preferences) will be displayed.  Select a database from the file open
dialog.  The Map Layer Options dialog shown below will then be displayed.

3. Set the Map Layer Options.
Layer Name - Enter a map layer name for the database.  Default layer name is the Database Name.
Certain layer names already used by MapPro are not permitted and an error message will be displayed
if one of these reserved names is entered.
Max Zoom to Display - This is the highest map scale in miles where map objects will be displayed.
Default is 0 which means always display. Some databases have 1000's of points and you may not
want to display the database once the map scale goes above a certain level because of the processing
time involved to display such a database or because the information displayed is not meaningful until
a much smaller map scale is reached.  Enter a value that suits your particular application.
Labeling Options - Map labels may be displayed for the objects in the User Database Layer.

Display Labels - Check this box if you want to display map labels for this layer.
Label with: - Select the field name from the pop-up menu that the map objects will be labeled
with.
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Font: - Select the font and font attributes to use for the labels.
Allow Duplicate Labels - Check this box if you want to allow objects with duplicate labels to all
be labeled. If not checked only one object with that text will be labeled.
Allow Overlapping - Check this box if you want all objects labeled even if the text overlaps the
text of another label.

To change the options for a database layer, select database name in the Database Name list
box then click on the Options button.  The Map Layer Options dialog shown below will then be
displayed.

To remove an existing database layer,  select database name in the Database Name list box
then click on the Remove button.

If more than one database layer exists the order of the database layers may be changed by using the
Up and Down buttons.  Select database name in the Database Name list box then click on the Up
or Down button to change the order.

5.3.7 Print Map

Print Map allows any or all of the maps available to be printed or sent to images files in a single
uninterrupted operation that requires no further operator intervention.  The printer and image output
settings are defined in User Preferences.  When Print Map is selected, the following dialog is
displayed:

Selected Output Destination - Displays the default Output Destination selected in User
Preferences. The Output Destination may be switched if desired.
Select Maps to Print - Displays all the available Maps that may be printed based upon the licensed
options and the Map data available.  The currently displayed map is selected by default but may be
deselected if desired. Select all the Maps that you wish to print or send to the Image Directory.
Options Button - There are several options that may be selected when printing. These options are
saved each time they are saved so they do not need to be redefined for each print operation.
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Selecting the Options button displays the following dialog:

Print Preview - This option is only available if Selected Output Destination is Printer. Selecting
this option caused a print preview of each map before it is printed.  Select this option if you want to
alter some aspect of the printed page such as changing the Map Title or creating some sort of non-
standard header. See Print Preview for details.

No Map Headers -  This option is automatically set if Selected Output Destination is Image
Directory since the images files generated are normally intended to be imported into other
applications that provide their own header. Headers are normally printed at the top of each printed
page.  In some cases, you may want to print the maps without this header.  Selecting "No Map
Headers." prevents these headers from being printed. With "No Map Headers" selected the printed
map is recentered vertically on page.

No County Map Insert on Location Map -  Prevents the small county map insert from being placed
on the bottom of the Location Map.

No Address Legend Insert on any Maps -  Prevents the Address Legend insert from being placed
in the bottom left corner of the all map pages. This option is automatically selected when a map
contains 10 or more property locations since size this legend will extend upwards on the map page
beyond the area reserved for legends. Selecting Property Details allows this address legend and
addtional information to be printed on a separate page if desired.

No Flood or Hazard Caution on Map - The Flood and Hazard Caution Messages that appear when
maps are displayed are printed at the bottom of the Flood and Hazard Maps respectively.  Checking
this box prevents these messages from appearing.

Increase bottom margin by: - MapPro prints to 0.4 inches from the bottom of the page. Many ink
jet printers are unable to print this close to the bottom of the page and will result in a loss of printed
information. This field allows the bottom margin to be raised by up to another 0.5 inches. Enter a
value in inches.

If the "No Map Headers" check box was not selected in the "Options" Dialog, one of the following
three dialog boxes is displayed where several fields of information that is printed in the header of the
printed maps is entered.  The fields required for the map header varies with the User Type set in
User Preferences.  Below are the three different dialogs displayed for each User Type.
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Real Estate Appraiser User Type.

Real Estate Broker User Type.

Other User Type.

After the Map Header information has been entered and if Print Preview was not selected under
Options, a dialog is displayed where the Number of Copies to print may be specified.

Once the print operation has started it is possible to abort the print operation.  When printing begins
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for each map page, a dialog displaying Printing Layout is displayed with a Cancel button.  There is also
a Print Stop button (looks like a Stop sign) displayed at upper left corner of the screen.  To abort the
print operation, repeatedly press the Enter key on the keyboard and click on the Print Stop button with
the mouse.  There is only a very small window of time between map pages where the print operation
may be aborted.

5.3.7.1 Print Preview

If the Print Preview option is checked, each map will be displayed on the screen prior to printing.
The content of the printed page may then be modified if desired using any of the
Drawing Tools Buttons or by double-clicking on text or by dragging objects on the page.  When the
Print button is selected on the Print Preview screen, the number of copies to print must be specified.
This mode of operation does require operator intervention prior to each map being printed.

Stop Print
Selecting Stop Print terminates the print preview of current map page without printing. If the
additional maps were selected for printing the next print previewed map will be displayed.

Unselect Objects
See Map Tools Buttons for details

Select Objects
See Map Tools Buttons for details

Zoom-In
See Map Tools Buttons for details

Zoom-Out
See Map Tools Buttons for details

Grabber
See Map Tools Buttons for details

Print
Select Print when all editing operations have been completed and you are ready to print the map.
The number copies to print may be entered.
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5.4 Map Tools Buttons

 Unselect Objects - Unselects all previously selected objects.  This button is disabled when

no objects are selected.

 Select Objects - The Select Objects Tool is used to select map objects. Once selected the

object is highlighted and may be moved, cut, copied or deleted from the map. Only objects on the
cosmetic layer may be moved, cut, or deleted from the map. The only objects on the cosmetic layer
after a map is displayed are the labels for streets, cities, points of interest, etc.  Other objects such as
lines, polygons, text, or symbols may be added to the cosmetic layer with the use of the Polyline
Tool, Polygon Tool, Text Tool, or Symbol Tool.

To move a map object:

1. Select the Select Objects Tool. This is the default selection, so unless you have used another tool
it should be already selected.
2. Move mouse pointer to object you wish to move and click on object to select it and hold down
mouse button.
3. If other objects exist in other map layers at the same point, it may be necessary to hold down the
Ctrl key while clicking to get the desired object selected.
4. Drag object to the desired destination and release mouse button.
5. Click on the Unselect Objects button or select Unselect All from the Edit Menu to unselect the
object.
6. Press Ctrl-Z or select Undo from the Edit Menu to undo the move.

To cut or delete a map object:

1. Select the Select Objects Tool.
2. Move mouse pointer to object you wish to cut or delete and click on object to select it.
3. If other objects exist in other map layers at the same point, it may be necessary to hold down the
Ctrl key while clicking to get the desired object selected.
4. Press Ctrl-X or select Cut from the Edit Menu to cut the object or
press Delete key or select Clear from the Edit Menu to delete the object.
5. Press Ctrl-Z or select Undo from the Edit Menu to undo the cut or delete.

To copy a map object:

1. Select the Select Objects Tool.
2. Move mouse pointer to object you wish to copy and click on object to select it.
3. If other objects exist in other map layers at the same point, it may be necessary to hold down the
Ctrl key while clicking to get the desired object selected.
4. Press Ctrl-C or select Copy from the Edit Menu to cut the object or
5. Press Ctrl-V or select Paste from the Edit Menu to put a copy of the map object in the cosmetic
layer.
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To select multiple objects hold down Shift key while selecting additional objects.

Draw Rectangle
The Draw Rectangle Tool serves two different purposes. The first more obvious one is it allows a
rectangular box to be drawn on the map.  Secondly, if a User Database Layer has been added to the
map, it allows objects from the User Database Layer within the rectangle to be selected and the
selected results saved in a DBF file.  For example, if you have a User Database Layer containing all
your customers added to the map, you might want to generate a list of which customers are located
within a certain rectangular area because you are trying to establish sales territories.  You can use the
Draw Rectangle Tool to accomplish this.

1. Add the desired User Database Layer to the map.
2. Select the Draw Rectangle Tool.
3. Draw the desired rectangle on the map.  This can be done in two different ways.
1. Starting where you want one corner of the rectangle to be drawn, click and hold the left mouse
button and drag the mouse diagonally across the map until you have the desired rectangle.  Release
the mouse button and the following dialog will be displayed. Set the desired Line Style.

or...
2. Move mouse pointer to a point on the map which you want to be the focal point of the rectangle.
Click and release left mouse button.  The following dialog will then be displayed.  Enter the North,
South, East, and West bounds of the rectangle and set the desired Line Style.

4.  If you have added other objects, i.e. lines, text, etc., on the map a question asking if you want to
"Delete existing objects from Cosmetic Layer?" will appear. If you answer Yes all objects you
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added are deleted.
5.  If a User Database Layer has been added to the map a question asking if you want to "Select
objects within Rectangle from Database Layer(s)?" will appear. If you answer Yes, select the
desired layers from the Database Map Layers dialog. Then enter the DBF file name where the selected
results will be saved.  Change the destination path if desired. If no objects are found within the
rectangle, a message notifying you of that fact will be displayed.

Draw Circle
Like the Draw Rectangle Tool the Draw Circle Tool can either draw a circle on the map only or
select objects from the User Database Layer within the circle to be selected and saved in a DBF file.

1. Add a User Database Layer to the map if desired.
2. Select the Draw Circle Tool.
3. Draw the desired circle on the map.  This can be done in two different ways.
1. Starting where you want the center of the circle, click and hold the left mouse button and drag the
mouse across the map until you have the desired size of circle.  Release the mouse button and the
following dialog will be displayed. Set the desired Line Style.

or...
2. Move mouse pointer to a point on the map where you want the center of the circle.  Click and
release left mouse button.  The following dialog will then be displayed.  Enter the Radius of the circle
and set the desired Line Style.

4.  If you have added other objects, i.e. lines, text, etc., on the map a question asking if you want to
"Delete existing objects from Cosmetic Layer?" will appear. If you answer Yes all objects you
added are deleted.
5.  If a User Database Layer has been added to the map a question asking if you want to "Select
objects within Circle from Database Layer(s)?" will appear. If you answer Yes, select the
desired layers from the Database Map Layers dialog. Then enter the DBF file name where the selected
results will be saved.  Change the destination path if desired. If no objects are found within the circle,
a message notifying you of that fact will be displayed.
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Draw Polygon
Like the Draw Rectangle Tool the Draw Polygon Tool can be used either draw a polygon on the
map only or select objects from the User Database Layer within the polygon to be selected and saved
in a DBF file.

1. Add a User Database Layer to the map if desired.
2. Select the Draw Polygon Tool.
3. Draw the desired polygon on the map by moving the mouse pointer the starting point for the
polygon. Click left mouse button to mark first point. Move mouse pointer to the next point of a
polygon, click to mark next point. Repeat this process until you have placed the last point of the
polygon. Double-click left mouse button to close polygon and the following dialog will be displayed.
Set the desired Line Style.

4.  If you have added other objects, i.e. lines, text, etc., on the map a question asking if you want to
"Delete existing objects from Cosmetic Layer?" will appear. If you answer Yes all objects you
added are deleted.
5.  If a User Database Layer has been added to the map a question asking if you want to "Select
objects within Polygon from Database Layer(s)?" will appear. If you answer Yes, select the
desired layers from the Database Map Layers dialog. Then enter the DBF file name where the selected
results will be saved.  Change the destination path if desired. If no objects are found within the
polygon, a message notifying you of that fact will be displayed.

Zoom-In
The Zoom-In Tool may be used to zoom-in on a certain area of the displayed map that you would
like to examine more closely.

To use Zoom-In Tool:
1. Click the Zoom-In button.
2. Move the mouse pointer to the center of the area you want to zoom in on.  Clicking the mouse
button then magnifies the area by a factor of two and the point where you clicked now becomes the
center of the map window.  You can repeat this procedure until you have the desired level of
enlargement.
OR
2. Draw a marquee around the area by dragging the Zoom-In pointer diagonally and release mouse
button.  The selected area enlarges to fill the map window.  The aspect ratio of the map window is not
changed however, so if you choose an area that has a very different shape from the window, you will
end up seeing a much wider or taller area of the map than you selected.

Zoom-Out
The Zoom-Out Tool may be used to zoom-out on a certain area of the displayed map that you would
like to see more of.

To use the Zoom-Out Tool:
1. Click the Zoom-Out button.
2. Move the mouse pointer to the center of the area you want to zoom out. Click the mouse and the
map size will increase by a  factor of two with the center of the map being at the point where you
clicked.  You can repeat this procedure as desired.
OR
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2. Draw a marquee by diagonally dragging the Zoom-Out tool across the window.  The area
displayed in the current map window then shrinks in size to fit inside the marquee area.

Grabber
The Grabber Tool allows the displayed map to be moved in any direction   Moving map only affects
the display and does not affect the map position when it is printed unless Dynamic Map Scaling has
been disabled.

To reposition a map:
1. Select the Grabber Tool button.  The cursor displays as a hand when moved over the map
window.
2. Click and hold down mouse button in an area of the map.  While holding down the mouse button,
drag the map in the desired direction.  When you release the mouse button, the map is redrawn in its
new location.

Info
The Info Tool may be used to display the data associated with any object on the map.

To display the data associated with map objects:
1. Select the Info Tool button. Mouse pointer becomes a crosshair.
2. Move mouse pointer on a map object and click mouse button.  The Info Tool Window is displayed.
If you have chosen a location where there are multiple overlapping objects, the bottom of the Info
Tool Window displays the number of objects selected and the number of tables containing those
objects.  The name on the left side of the window is the layer name followed by the first field of data
associated with the object.  Note the example below.

3. Choose an object from the list and all the data associated with that object will be displayed.  Use
the scroll bars on the right side of the window to view all the fields if necessary or stretch the size of
the window.
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The arrow buttons allow you to go back and forth between the objects that you selected.
Clicking the List button returns you to the previous window that lists the objects.

Label
When a Map is displayed the software automatically labels the objects on the map.  Normally the
automatic labeling does a good job of labeling various objects on the map, but occasionally you may
want an object on the map labeled that was not automatically labeled.  When this occurs you can use
the label tool to label those objects.

To use the Label Tool to label a object:
1. Select the Label Tool button
2. Click on an object with the Label Tool and a label appears.

Several map layers contain boundaries, such as zip codes and census tracts, that are not visible on the
screen.  These boundaries may also be labeled.  To determine the what invisible boundary layers exist
at any point on the map use the Info Tool.  The number and order of the map layer objects are listed
in the Info Window.

To label objects in other map layers:
1. Select the Label Tool button
2. Hold down the <Ctrl> key and click with Label Tool at the point of interest on the map.  the top-
most layer will be labeled.
3. While continuing to hold down the <Ctrl> key, click at the same point again.  The next layer down
is labeled.
4. Repeat step 3 as often as needed.
5. Use the Select Objects Tool to move labels or delete unwanted labels.

Note: If the original map scale was changed with either the Zoom-In Tool or the Zoom-Out Tool
the labels will be displayed and printed smaller or larger than the other labels in the same map layer.
Restore original map scale and position before using the Label Tool.

Ruler
The Ruler Tool allows you to measure the shortest distance between two points on a map or the
distance along a selected path.
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To measure the distance between two points:

1. Select the Ruler Tool from the Menu Button Bar and the Ruler window displays.
2. Click at the point where you want to start measuring.

Distance in the Ruler window is the distance between the point where the mouse was last clicked and
the current mouse pointer position.  As you move the cursor, you will see the distance measurement
change in the Ruler window. You can position the Ruler window anywhere on the screen.

Total is the total of all the distances measured during the current use of the Ruler tool.

3. Click a second point. Distance is added to the total distance.  If you are only measuring the distance
between two points, you are done;  double-click to terminate the measurement.  If you are measuring
the length of a
path containing more than one segment:

4. Continue this process to keep a running total of the length of a multi-segment path.  This is useful
when you want to follow along a street in a map and see how long the street is.  You can also use it
to find the distance along a path that includes various streets and roads.

5. Double-click the mouse button when you have completed the measurement.

You can now start another measurement or choose a new tool.  When you choose a new tool, you
may want to close the Ruler window.

Note: To change the units of measure, select Set Map Distance Units from the Map Menu.

City Demographics
The City Demographics Tool allows year 2000 US Census City Demographics profiles to be displayed.
In order for this to work properly the Census Demographic Profile data for the State or States
currently licensed must be downloaded and installed from MapPro's Support Web Site @
www.mappro.net.  This button will be enabled when any map is displayed after the demographic
profile data has been downloaded and installed.  Adobe's Acrobat Reader is used to display these
profiles. The Acrobat Reader may be downloaded free from Adobe's web site.

To display a the Census Demographic Profile for a city, display either a location, flood or hazard map.
After map is displayed select the City Demographics button and click on the map in the city of interest.
The profile will be displayed with Acrobat Reader.

Additional Demographic profiles may be display by selecting Census Demographic Profiles from the
Help Menu.

5.5 Drawing Tools Buttons

The Drawing Tools Buttons are used when the User wants to add lines, polygons, text, or symbols to a
map.  These buttons are normally not displayed on the tool bar but may be displayed by selecting
Show Drawing Tools Buttons on the Options Menu.
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Set Line Style - Set Line Style allows the style, color, and width of the line to be set

prior to using the Polyline Tool.  In order to change the line style of a line that you have already
drawn, select the line using the Selector Tool, then change the line style with Set Line Style.

Polyline Tool - The Polyline Tool allows a single or a multiple segment line to be drawn

on a Location or Flood Map.  This tool can be used to add some feature to the map such as a
neighborhood or subdivision boundary or a new street not shown on the map.  Prior to selecting this
tool, set the line style, color, and width by clicking on the Set Line Style button.  Then:

1. Click on the Polyline Tool button.  The mouse pointer will look like a +.
2. If you are drawing over streets or connecting to street intersections or other objects on the map,
turn on Snap by typing the letter "S".
3. Move the mouse pointer to where you want to begin drawing and click the mouse button once.
4. Move the mouse pointer to draw the first line segment.
5. Click the mouse button once if you want to terminate the current line segment and continue
drawing or double-click to stop drawing.  By pressing the Shift key while drawing a line, the line
segments are constrained to horizontal, vertical,
and 45-degree diagonals.

Use the Zoom-In Tool, Zoom-Out Tool, or the Grabber Tool to adjust the view of the map as
needed before or after drawing lines.

To move or delete a line see Select Tool
To copy lines you have drawn to another map see Copying Map Objects
To put a label on a line you have drawn see Text Tool

Set Polygon Style - Set Polygon Style allows the pattern, color, and background color

(if any) of the fill and style, color, and width of the border to be set before using the Polygon Tool.
To change the style of a polygon you have already drawn, select the polygon with the Select Tool,
then change the settings with Set Polygon Style.

Polygon Tool - The Polygon Tool allows multi sided areas to be drawn on a displayed

Map.  This tool can be used to add some feature to the map such as a shopping center, tract of land,
or the outline of a large building.  Prior to selecting this tool, set the fill and border style by clicking on
the Set Polygon Style button.  Then:

1. Click on the Polygon Tool button.  The mouse pointer will look like a +.
2. If you are connecting the polygon to existing objects on the map, such as streets, waterways, or
other objects on the map, turn on Snap by typing the letter "S".
3. Move the mouse pointer to where you want to begin drawing and click the mouse button once.
4. Move the mouse pointer to draw the first line segment.
5. Click the mouse button once if you want to terminate the current line segment and continue
drawing or double-click to stop drawing.  By pressing the Shift key while drawing a line, the line
segments are constrained to horizontal, vertical,
and 45-degree diagonals.

Use the Zoom-In Tool, Zoom-Out Tool, or the Grabber Tool to adjust the view of the map as
needed before or after drawing lines.
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To see the length of the perimeter, area, and earth coordinates of the polygon you have drawn,
double-click on the polygon with the Select Tool.
To move or delete a polygon see Select Tool
To copy a polygon you have drawn to another map see Copying Map Objects
To put a label on a line you have drawn see Text Tool

Set Text Style - Set Text Style allows you to set the Font, Size, Attributes, Text Color

and Background Color (if any) before entering text on a map with the Text Tool.  To change the text
style of text already on the map, select the with the Select Tool, then change the settings with Set
Text Style.  It is also possible to rotate the text by double-clicking on the text and then setting the
angle of rotation in the dialog.

Text Tool - The Text Tool allows additional text to be placed on the map at any desired

location.  Before selecting the Text Tool, set the font, attributes, size and color of the text with the
Set Text Style button.

To add text on a map:

1. Set text style.
2. Select Text Tool button. The mouse pointer changes to a I-beam when moved over map.
3. Place mouse pointer to the point on the map where you want to place the text and click once.
4. Type the text desired.
5. Then either select the Select Tool or move mouse pointer to another location on map where you
want to additional text and click once. Type the text desired.

To change existing text on the map:
1. Select the Select Tool.
2. Position mouse pointer over the text you want to change and double-click.
3. Edit the text in the dialog as needed.
4. The text style, rotation, and justification may also be changed from this dialog.

Set Symbol Style - Set Symbol Style allows the symbol type, color, and size of the

symbol to be set prior to using the Symbol Tool.  To change the settings for a symbol you have
already placed on the map, select the symbol with the Select Tool, then change the settings with Set
Symbol Style. All fonts that start with "MapInfo" in the name are mapping symbols installed with
MapPro.

Symbol Tool - The Symbol Tool allows a variety of different symbols to be placed on the

map in order to show a particular point of interest that you want to call attention to on a map.  Set
the symbol style with the Set Symbol Style button before selecting the Symbol Tool.

To place a symbol on a map:
1. Set Symbol Style.
2. Select Symbol Tool. Mouse pointer changes to a + when moved over the map.
3. Position mouse pointer to the point on the map where you want the symbol to be placed and click
once.
4. Repeat step 3 as often as desired.
5. Select the Select Tool when finished.
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Snap Feature - The Snap Feature causes the mouse pointer to snap to the closest node of an

existing object on the map. This is very useful when adding new lines or polygons to the map that you
want to connect to some object already on the map.  To turn on the Snap Feature simply type the
letter "S" on the keyboard.  Note that when Snap is turned on the word "SNAP" appears at the bottom
of the screen and you will notice a large + with dashed lines appear when the mouse pointer is moved
close to an existing object on the map. To turn off the snap feature simply type the letter "S" again.

Copying Map Objects - When text, lines, polygons, or symbols are added to a map, these

objects are placed in the cosmetic or top layer of the map.  If the map is redisplayed or if another map
is displayed, anything added to this layer of map is discarded.  In order to save these objects so that
do not have to be recreated the objects may be copied to the Windows Clipboard and then pasted
onto the new map that is displayed.

To copy objects to another map:
1. Select the Select Tool.
2. Select the objects you wish to copy. Hold down the Shift key to select more than one object.
3. Type "Ctrl-C" or select Copy from the Edit Menu to copy the selected objects to the Windows
Clipboard.
4. Display the Map that you wish to copy the objects to.
5. Type "Ctrl-V" or select Paste from the Edit Menu to paste the contents of the Windows Clipboard
onto the map.
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6 Arrow Maker

6.1 Arrow Maker Utility

The Arrow Maker Utility allows the to create or modify annotated arrows that are used on Map Maker
maps.  The Utility is initiated by clicking the Arrow Maker Button on the Startup Button Bar.  The
dialog below is displayed when Arrow Maker is started.  The 12 arrow types displayed in the dialog are
the default arrow types installed by MapPro. These arrows may be modified if desired.  Users of
Appraise-It should not modify the order of the arrows because the MapPro/Appraise-It interface
automatically assigns these arrow types and therefore expects them to be in this pre-defined order. In
order to view any existing arrow in the "Type" list, select the arrow type by clicking on it with the
mouse and all four rotations of both the large and small arrow will be displayed.

Adding an Arrow Definition
When the Add button is selected on the Arrow Maker Utility dialog the following dialog is displayed.
The Arrow Font, Border, and Fill defaults to these attributes for the last arrow in the list.  Type the
text desired for the arrow in the Arrow Text field.  Adding a '#' character at the end of the arrow text
will cause Map Maker to number the arrows sequentially starting a 1 for each Map Point Location of
that type.  Due to the limited space for text inside the arrows, arrow text of only 6-9 characters will fit
inside arrow depending upon the font and font attributes being used.  Select Arrow Font, Arrow
Border, or Arrow Fill to change their respective attributes. Note that the Size attribute for Arrow Font
has no effect on the actual size of the font in the arrow.  The font size is automatically scaled to
maximum size possible that will fit into the arrow.  Select the Show button at any time to preview the
arrows appearance.
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Changing an Arrow Definition
To change an Arrow Definition click on the arrow type in the list box. You will see a preview of the
arrow in the Arrow Viewer window. Click the Change button to change the Arrow Definition.

Removing an Arrow Definition
To remove an Arrow Definition click on the arrow type in the list box. You will see a preview of the
arrow in the Arrow Viewer window. Click the Remove button to remove the Arrow Definition.
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7 Database Utility

7.1 Database Utility

The Database Utility is a MapPro feature that provides users the capability to create databases and
import existing Microsoft Access or dBase databases.  These databases may then be geocoded (the
process of assigning X and Y coordinates to the database records so they can be displayed as objects
on a map) and then added as layers to the map.  These geocoded databases normally reside on the
hard disk of the Users PC, but they may also be created and reside on a network drive so they may
shared by all users on a network.  See the Database Directory Path setting in Directory Preferences
for details.

The Database Utility is initiated by clicking on the Database Utility button on the Startup Button Bar.
After it is initiated the Database Utility Buttons and Menu are displayed.

Below is a list of the fields that are required in a MapPro Database. Field names in a imported
database do not need to be the same as is required for MapPro.  Many databases though may not
have all parts of the street address concatenated together in a single field. If this is the case use your
primary database application to create an Address field with all the street address info concatenated.

Field Name Type Width Comment
Address Character 40 (Recommended, must be long enough for long street names)
NotAddr Logical N/A (Description in address field indicator)
City Character 30 *
Zip Character 5 (5 Digit Zip Code - 9 Digit Zip Codes not currently supported
for geocoding)
County Character 30 (If County field is blank Zip Code must be provided in order to
geocode address)*
Grid Character 8 (Paper map grid location)*
Latitude Decimal 9 (Decimals = 6)*
Longitude Decimal 11 (Decimals = 6)*
GeoResult Integer N/A (Holds the Result Code of geocode operation)
GeoStat Logical N/A (TRUE if record has been geocoded, FALSE if it has not been
geocoded)
RecNum Integer N/A (Holds record number)#

* Contents of these fields not required. Will be updated during geocoding process.
# Record Number field automatically updated by MapPro.

7.2 Database Utility Buttons

New Database
New Database is used to create a new database or import an existing database.  All databases that
are created are saved in dBase DBF format.  Databases that are imported must be in dBase DBF
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format or in Microsoft Access format.  All MapPro databases are saved in the Database Directory Path
defined in Directory Preferences.

To Import an Existing Database:
1. Click on the New Database button and select "Yes" on the "Import Data from Existing Database?"
dialog.
2. A dialog will be displayed and you will then be asked to select the format of data to import:

3. A dialog is then displayed to select the database to be imported. Change directory, if necessary, to
locate the database to be imported.  If the database is located in a directory other than the directory
specified by the Database Directory Path in Directory Preferences, the database is copied to the
Database Directory.
4. If you are importing an Access Database the following dialog will be displayed. An Access database
may contain multiple tables so the specific table to be imported must specified.

5. You will then be asked to "Enter New MapPro Table Name". You may use the same name as import
file name or assign a new name.
6. The fields of the database are then examined to determine if the fields required by MapPro exist.  If
the required field exists, it is assumed that the field contains the required information and the existing
field is used.  If the required field does not exist, a message similar to the one below is displayed:
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If a field containing the required information exists but has a different field name, select the field
containing the required information and select "OK".  The existing field name is then changed to the
required field name.  In above example "Address1" field contains the street address.  If the field does
not exist click the "Add" button and a new empty field will be created.
The above process will be repeated until all the required fields have been selected or created.  The
contents of the database is then displayed on the screen in a Browser Window.

Note: If you are importing a Microsoft Excel spreadsheet, the Database Field Names displayed will
be the column letters (I.E. A, B, C, D, etc.) therefore make sure you know how the speadsheet is
organized so the correct column can be assigned. If the first row in the speadsheet contains the field
names then delete this row from the database after the correct field names have been defined. Use
the Modify Structure button to alter field names in database that are not one of the required fields.

To Create a New Database:
1. Click on the New Database button and select "No" on the "Import Data from existing Database?"
dialog.
2. You will then be asked to "Enter New Database Table Name". Enter a name for the database.
3. A new empty database will then be created with the field names and characteristics shown in step 5
above.  A Browser Window will then be displayed showing the field names of the new database.
4. Use the Modify Structure button to add addition fields to the database.
5. Use the New Record button to add records to the database.

Open Database
Open Database is used to open an existing MapPro database.

To Open a Database:
1. Click on Open Database button.
2. Select an existing database to open from the Database Directory.
3. The selected database is opened and displayed in a Browser Window.

Save Database
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Save Database is used to permanently save any changes made to a database.  This button will only
be enabled if there are unsaved changes to a database.

Revert Database
Revert Database is used to permanently discard any unsaved changes made to a database.  This
button will only be enabled if there are unsaved changes to a database.  When the Revert Database
button is selected, you are given the opportunity to either discard the changes or cancel the revert
database operation.

Print Database
The Print Database button may be used to print all or a selected portion of a open database.
Depending upon the number and width of the fields in the database, several pages in width may be
required to print the contents of the database records.  When the print dialog is displayed, the default
Windows printer is selected.  Change printer and printer properties (i.e. paper size, portrait/landscape)
as needed.  If you wish to print only a portion of the database select Options button on the Print
dialog and enter a From and To range.

Close Database
Close Database is used to close a open MapPro database.  The Close Database button is only
enabled if a database is currently open.  If the database has any unsaved changes, you are given the
option of either saving the changes, discarding the changes, or canceling the Close Database
operation.

Exit Database Utility
Exits the Database Utility and displays the Startup Buttons.  If a database is currently open a
Close Database operation is performed before exiting.

New Record
New Record causes a new blank record to be appended to database and displayed at the bottom of
the Browser Window.

An alternate way to add a new record.
If several of the database fields of the new record you want to add contain the same information as
another record in the database, an easier way to add the new record is to:
1. Locate the similar record in the database.
2. Select the record by clicking on the box at the left side of the Browser Window next to the record.
3. Click on the Copy button on the Database Utility Button Bar.
4. Click on the Paste button on the Database Utility Button Bar.  The copied record will be appended
to the database.
5. Modify the fields of the pasted record that are different.  If the Latitude and Longitude fields contain
non-zero values, this indicates that the copied record was previously geocoded and when this record
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was copied the geocoded map symbol was also copied.  In this case, since the geocoded map symbol
already exists, the new record will have to be geocoded by selecting the new record and performing a
geocode of "Selected Records Only".  This allows the copied map symbol to be moved to the
correct location.  See Geocode Database for more information.

Modify Structure
Modify Database Structure is used to add, remove, or change the order of fields in your database.
The field type and field width (number of characters) may also be specified.  MapPro databases must
contain several pre-defined fields of information in order for the database to work correctly with
MapPro. When a new database is created in the Database Utility these fields are automatically
defined.  If a database is imported, the Database Utility looks for each of these pre-defined fields.  If
the fields cannot be found in the imported database,  a dialog is displayed where the field name
containing the required information can be selected or a new field added to the database if it does not
exist.  Below is a list of the required fields with their name, type, and width:

Field Name Type Width Comment
Address Character 40 (Recommended, must be long enough for long street names)
NotAddr Logical N/A (Description in address field indicator)
City Character 30
Zip Character 5 (5 Digit Zip Code - 9 Digit Zip Codes not currently supported
for geocoding)
County Character 30 (If County field is blank Zip Code must be provided in order to
geocode address)
Grid Character 8 (Paper map grid location)
Latitude Decimal 9 (Decimals = 6)
Longitude Decimal 11 (Decimals = 6)
GeoResult Integer N/A (Holds the Result Code of geocode operation)
GeoStat Logical N/A (TRUE if record has been geocoded, FALSE if it has not been
geocoded)
RecNum Integer N/A (Holds record number)

Note: The order of required fields is not important and may be changed.

All MapPro databases must be mappable. DO NOT remove the check in the Table is Mappable
check box.  Doing so will cause all map objects (symbols) for the database to be DELETED
and the database will have to be geocoded again.

At the top of the Modify Table Structure dialog is a box that lists the fields in order from top to
bottom.  To choose a field from this box, click on its name and the field is highlighted.

Field - This column contains the names of the fields (columns) in the table from top to bottom.
Type - Indicates the type of field with the number of characters in the field listed in parentheses
(where applicable).
Indexed - An "X" in this column indicates the field is indexed.  MapPro databases do not need
indexing on any field.  When the column is blank, the field is not indexed.
Up/Down - Allows you to move the selected field up or down one position in the list box.  The file
structure is reorganized accordingly.  Moving a field up or down has the effect of moving it left or right
in a Browser.  When a table displays in a Browser, the first field becomes the leftmost column, the
second field becomes the second column from the left, and the last field becomes the rightmost
column.
Add Field - Allows you to add a new field at the bottom of the list.  This field has a default name of
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field1, field2, field3, etc., depending on the order in which the field was created.
Remove Field - Allows you to remove the selected field from the table.
Table is Mappable - Always is checked for MapPro.
Projection button - Displays the Map Projection used.  MapPro uses Latitude/Longitude (NAD 83 for
US)

Field Information - Allows you to specify information about the fields.
Name - Allows you to enter the name of the new field in the Name box.   Defaults are field1, field2,
etc.   A field name can be up to 31 alphanumeric characters long.  You can use letters, numbers, and
the underscore.  Do not use spaces; instead, use the underscore character ("_") to separate words in
a field name.  You can use upper and lowercase for legibility, but MapInfo is not case-sensitive.
Type - A drop down list is used to indicate the field type.  The following types are available:

Character:  Stores  up to 250 alphanumeric characters.  You cannot perform arithmetic
operations on numerals in a character field.  You should store ZIP Code information in character
fields, otherwise leading zeros are dropped.
Decimal:  Stores numbers in fixed-point decimal form.  Do not put commas in decimal
Integer:  Stores integers (numbers without a decimal).  The range is from -2 billion to +2 billion
Small Integer: Integers between -32,767 and +32,767.  Small integers take up less space.
Float:  Stores numbers in floating-point decimal form.
Date: These fields can contain a calendar date in the format MM/DD/YYYY.  The year can be
specified by two or four digits and is optional.  Use slashes or hyphens to separate components of
a date.  The following are valid dates: 01/23/91, 5-6-1989, 10/07.
Logical: These fields contain only true/false or yes/no information, stored as "T" for true/yes and
"F" for false/no.

Decimal, integer, small integer, and float can only contain numeric symbols.  These fields do not
accept any characters besides numbers, the minus sign, or decimal points for decimal and
floating-point numbers.

Width - Type the number of characters in the field (character and decimal fields only).  Maximum
field width is 250 for character fields and 19 for decimal fields. A valid decimal value has a total
number of characters, including the decimal point, minus sign if negative, and padding to precision if
necessary, not to exceed the decimal width.

Note: If you insert a data value that is out of range, the bad value will be inserted with no error
displayed.

Pack Database
The Pack Database button allows you to compress a database so that they use less disk space and
to eliminate records that have been marked as deleted.  It is normally not necessary to pack a
database unless you have deleted database records.

Sort Database
Sort Database allows the records of a User database to be sorted in a specific order based upon the
contents of one or more selected fields.  This enables the database records with like characteristics to
viewed in a logical order.  Fields may sorted in ascending or descending order.

To Sort a Database:
1. Click on Sort Database button.  A dialog similar to the one below will displayed.
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2. Select the first sort field from the Database Fields list box.  If you want to sort the field in
descending order check the Descending Order check box. Then click the >>Add>> button.  The
selected field is added to the Sort Order list box.  You may also double-click on the field name
3. Repeat step 2 for additional fields as you want sorted.  Select Clear to clear the Sort Order list
box if you make a mistake.
5. After the Sort Order list box contains the complete sort order list, select OK and the database will
be sorted and redisplayed.

Geocode Database
The Geocode Database button is used to initiate the geocoding (the process of assigning X and Y
coordinates to the database records so they can be displayed as objects on a map) operation for a
database.  Geocoding normally involves a three step process.  First, records are geocoded in an
automatic mode which requires no operator intervention.  Second, records are geocoded in an
interactive mode where the operator can make corrections in the street name and zip code.  Third, a
manual geocoder is used to place the location for records that can't be found.

Prior to attempting to geocode a database, visually inspect the records of the for the
following:
1. Address field of records contain a full street name (i.e. street number followed by directional prefix,
if any, followed by street name followed by the suffix followed by directional suffix if any.) Not all
street addresses have all these attributes.  Example: "2200 W Sam Houston Pkwy S" contains all the
above attributes.  The most common problem with geocoding street addresses is a missing suffix such
as St, Ln, Dr, Ave, Ct, Cir, Rd, etc.  With some common street names, all of these suffixes may be
used with a particular street name somewhere in the county, and sometimes more than once.

2. NotAddr field should contain "F" (False) if the address field contains a street address.  If address
field contains a description the NotAddr should contain "T" (True).

3. Zip field contains the correct zip code.  When duplicate street names exist in a county, the zip code
is used to limit the search to a specific zip code.  No automatic geocoding may be performed without
supplying the correct zip code.

4. County field contains the correct county name. All geocoding is performed at the county level,
therefore without the county names correctly entered, geocoding cannot be performed. Although most
zip codes are entirely contained within a county, zip codes along county boundaries sometimes span
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two counties.

After visually inspecting the records of the database and making any needed corrections, you should
now be ready to geocode the database.

To Geocode a Database:

First Geocoding Attempt.
1. Open the database to geocode.
2. Perform the visual inspection on the database outlined above.
3. Click on the Geocode Database button.  The following dialog will be displayed:

4. Select the Records to Geocode.  The first time geocoding is performed on the database
Ungeocoded Records Only and Geocode All Records is the same since all records are
ungeocoded.
5. Select the Type of Operation.  This will normally be set to Geocode using Address/Zip unless
the database already contains the Latitude and Longitude.
6. Select the Mode.  On your first geocoding pass through the database use Automatic. Automatic
mode requires no operator intervention.
7. Click on the Options button and select any of the options desired.

8. Select the Map Symbol to use.  The currently selected symbol is displayed but there are 100's to
choose from.
9. The Database Utility will then attempt to geocode records specified.  The Latitude & Longitude are
updated if geocoding using address/zip and a map object is created using the selected symbol.  The
number of successfully geocoded records will be displayed at the end of the geocoding operation.
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Second geocoding attempt.
1. After the first geocoding pass is complete, you may want to perform a Sort Database at this point.
Sort the database first by GeoResult in decending order Latitude and then by Zip.  This will place all
the ungeocoded records together at the top of the database grouped by zip code.
2. Visually inspect the Address, Zip, and County fields of these records looking for obvious problems
and correct them as needed.
3. Click on the Geocode Database button to initiate the second geocoding attempt.
4. Select Ungeocoded Records Only or if there are a large number of ungeocoded records, you may
want to select a group of 10-20 records at a time and process the ungeocoded records in batches by
using Selected Records Only.  Records are selected by clicking on box (box becomes black) on the
left side of the Browser Window. Multiple records may be selected by holding the "Shift" key down
while selecting records.  Several adjacent records may be selected by holding the "Shift" key down
and click and hold the left mouse button down on the first record in the group, and drag the mouse
pointer over all the boxes of the records to be selected.
5. Select Geocode using Address/Zip, and this time select Interactive for Mode.  When
Interactive mode is selected, if any error is encountered in the processing of a record, a dialog, error
message, or question is displayed which must be responded to by the user before processing will
continue.  The Symbol should still contain your previous selection.
6. In this interactive mode, the Database Utility will display a Find dialog to resolve problems with the
street name, address number, or zip code in the same way as when Map Point Data is entered.
7. If the address problem cannot be resolved the address may be bypassed by selecting Cancel on
the Find dialog.  When Cancel is selected dialog is displayed asking if this ungeocoded record should
be added to the manual geocode list.  If "Yes" is selected, the record is added to a manual geocode
list.  The records added to this list are processed by the Manual Geocoder after all records to
geocode are processed.

Manual Geocoder
Manual Geocoder is used to manually set the location of database records that cannot otherwise be
located.  At the completion of an Interactive geocoding pass, records that were added to the Manual
Geocode List are processed by the Manual Geocoder which is automatically started. The Manual
Geocoder can also be started with the button if the User wants to view the geocoded database or
move the location of icons on the map. See Manual Geocoder for details on how to use this feature.

7.3 Database Utility Result Codes

The following table is a list of result codes and their definitions that are stored in the GeoResult field of
the database after a database has been geocoded.  Sorting the database in GeoResult order can be
performed after the geocoding has been initially completed.  This allows user to visually see how the
database was geocoded or allows ungeocoded records to be grouped together for editing.

GeoResult Definition
0 Ungeocoded – Has Not Been Run Through MapPro Geocoder
1 Geocoded - Exact Geocode Match
2 Geocoded - Abbreviation Substitution
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3 Geocoded - Relaxed Zip Code and Abbreviations
4 Geocoded - One Possible Match Found with Entered Street Number and Root

Street Name
5 Geocoded - Multiple Address Possibilities, User Selected
6 Geocoded - Advanced Search
7 Geocoded - Center of Entered Grid
8 Geocoded - Center of Zip Code
9 Geocoded - Manually Placed
20 Geocoded - Located by User Entered Lat/Long
31 Geocoded - Exact Intersection Geocode Match
32 Geocoded - Abbreviation Substitution on Intersection
33 Geocoded - Relaxed Zip Code and Abbreviations for Intersection
34 Geocoded - One Possible Intersection Match Found at both Root Street

Names
35 Geocoded - Multiple Intersection Possibilities, User Selected
36 Geocoded - Intersection Advanced Search
100 UnGeocoded - Multiple Matches Found; Unable to Geocode in Auto Mode
107 UnGeocoded - Multiple Matches Found; Unable to Geocode in Auto Mode;

Located at Center of Grid
108 UnGeocoded - Multiple Matches Found; Unable to Geocode in Auto Mode;

Located at Center of Zip Code
137 Geocoded - Multiple Matches Found; Unable to Geocode in Auto Mode;

Located at Center of Grid
138 Geocoded - Multiple Matches Found; Unable to Geocode in Auto Mode;

Located at Center of Zip Code
800 UnGeocoded - Unable to Geocode, but in a geocodeable format
807 Geocoded - Geocoded to Grid; No Street Matches Found but in a format that

may be geocodeable
808 Geocoded - Geocoded to Zip Centroid; No Street Matches Found, but in a

format that may be geocodeable
900 UnGeocoded - Indication that it is in unlicensed area
999 UnGeocoded - Unable to Geocode, either in an ungeocodeable format or

absolutely no matches found
9999 UnGeocoded - No Zip or County information included.  Impossible to Geocode

without one of these values.

7.4 Manual Geocoder

The Geocode Database function of the Database Utility has a special Manual Geocoder which is used
to manually set the location of database records that cannot otherwise be located.  At the completion
of an Interactive geocoding pass, records that were added to the Manual Geocode List are processed
by the Manual Geocoder.

When the Manual Geocoder starts it obtains the first record from the Manual Geocode List.  It then
opens a map window containing all the various street layers, zip code layer, city layer, county layer,
grid layer (if available), and a layer containing the database that is being geocoded.  The map window
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is then positioned as follows:

1. If a Grid location is contained in the record and the grid layer is available, the map zooms in to the
specified grid location.
2. If step 1 cannot be performed, the map zooms in to the specified Zip contained in the record.
3. If neither of the above can be performed, the map zooms in to the City contained in the record.
4. If none of the above can be performed, the map zooms in to the County contained in the record.
5. If none of the above can be performed, the map for the entire licensed area is displayed.

A message window is then displayed at the top of the screen with the message "Find Location:"
followed by the address contained in the first record.  The Manual Geocoder Button Bar shown below
is also displayed.

The first two buttons are the only buttons which are unique to the Manual Geocoder.

Manually Geocode Address
The Manually Geocode Address button is used to manually mark the location where the map
symbol will be placed.

To Manually Geocode an Address:
1. Use the map tools to find the location on the map where the map symbol should be placed.
2. Click on the Manually Geocode Address button.  Mouse pointer changes to a cross-hair.
3. Move mouse pointer to the location where the map symbol should be placed and click left mouse
button.
4. The Latitude & Longitude are retrieved and the map symbol is placed on the map.

Next Address
Skips the current address in the Manual Geocode List and the next address is processed.

Use the other map tools as aids to find the location of the address.
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